
HP VISUal User Environment 
User's Guide 

G 0 l 0 



HP Visual User Environment 

User's Guide 

F/iOW HEWLETT 
a:~ PACKARD 

HP Part No. 81171-90042 
Printed in U.S.A. November 1991 

Edition 2 



Notice 
The information contained in this document is subject to change without 
notice. 

HEWLETT-PACKARD MAKES NO WARRANTY OF ANY KIND WITH 
REGARD TO THIS MANUAL, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. Hewlett-Packard shall not be liable for 
errors contained herein or direct, indirect, special, incidental or consequential 
damages in connection with the furnishing, performance, or use of this 
material. 

warranty 

A copy of the specific warranty terms applicable to your Hewlett-Packard 
product and replacement parts can be obtained from your local Sales and 
Service Office. 

Printing History 

The printing date will change when a new edition is printed. Minor changes 
may be made at reprint without changing the printing date. The manual part 
number will change when extensive changes are made. 

Manual updates may be issued between editions to correct errors or document 
product changes. To ensure that you receive these updates or new editions, see 
your HP sales representative for details. 

November 1991 ... Edition 2 

Hewlett-Packard Company 
Interface Technology Operation 
1000 N .E. Circle Blvd. 
Corvallis, OR 97330 

© 1991 Hewlett-Packard Company. 



Contents 

1. A bout HP VUE 
Are You Ready? ....... . 
An Overview of HP VUE ... . 

Your Workstation and HP VUE 
A Look at HP VUE . . . . . 

The Six HP VUE Managers 
HP VUE and Applications . 

Using HP VUE Tutorials 
Where to Find Additional Information. 

2. Getting Started 
Module 1: Using a Mouse .......... . 
Module 2: Recognizing Pointer and Cursor Shapes 
Module 3: Working with Windows 
Module 4: Logging In . . . . . . 
Module 5: Renaming a Workspace 
Module 6: Switching Workspaces . 
Module 7: Opening the Style Manager. 
Module 8: Changing a Workspace Backdrop Pattern 
Module 9: Changing Workspace Colors ..... . 
Module 10: Choosing from a Menu . . . . . . . . 
Module 11: Opening and Closing a Terminal Window 
Module 12: Opening the File Manager ..... 
Module 13: Creating a Directory . . . . . 
Module 14: Opening Another File Manager 
Module 15: Creating a File . . . . . 
Module 16: Copying a File. 
Module 17: Renaming a File 
Module 18: Moving a File . 
Module 19: Removing a File 

1-1 
1-3 
1-3 
1-4 
1-6 
1-6 
1-7 
1-8 

2-2 
2-3 
2-4 
2-6 
2-8 
2-9 
2-9 

2-10 
2-11 
2-12 
2-13 
2-14 
2-15 
2-16 
2-17 
2-18 
2-19 
2-20 
2-21 

Contents-1 



Module 20: Restoring a File . . . . . ..... . 
Module 21: Finding a File . . . . . . . . . . . . 
Module 22: Going Up the Directory Tree (Hierarchy) 
Module 23: Removing a Directory ......... . 
Module 24: Opening the Help Manager Index 
Module 25: Selecting and Viewing a Help Topic 
Module 26: Making a Copy of Help Text. 
Module 27: Logging Out .......... . 

3. Managing Your Session 
Logging In ............. . 

Logging into an HP VUE Work Session 
Logging into a Fail-Safe Session. . . . 
Logging in Without Windows (HP-UX Only) . 
Correcting Login Mistakes 
Getting Help Logging In . . . . . . . . . 

Changing Languages ......... . 
Why and How Often to Restart the X Server 
Securing Your System . . . . . . . . . . 

Creating and Changing Your Password 
Locking and Unlocking Your HP VUE Session 

Displaying the Copyright Message. . 
Logging Out ............ . 

Confirming Your Logout ...... . 
Restarting or Restoring Your Session . . . . . 

Canceling a Session . . . . . . . . . 
Shutting Down the System . . . . . . 

4. Managing Your Workspaces 
Using the Workspace Manager ..... 

Reading Workspace Manager Indicators 
Starting Workspace Manager Services . . . . 
Switching Workspaces . . . . . . . . . . ... . 
Renaming a Workspace . . . . . 
Adding and Removing Workspaces 
Hiding the Workspace Manager . . 
Logging Out from the Workspace Manager 
Getting Help on the Workspace Manager .. 

Contents-2 

2-22 
2-23 
2-24 
2-25 
2-26 
2-27 
2-28 
2-29 

3-2 
3-2 
3-2 
3-3 
3-3 
3-4 
3-4 
3-4 
3-5 
3-5 
3-6 
3-7 
3-7 
3-8 
3-8 
3-9 
3-9 

4-2 
4-2 
4-3 
4-4 
4-5 
4-5 
4-6 
4-6 
4-6 



Choosing Commands from the Workspace Menu 
U sing the Window Menu. . . . . . . . 
U sing Menu Mnemonics and Accelerators 

U sing Menu Mnemonics . 
U sing Menu Accelerators . 

Sending and Receiving Mail 
Printing . . . . . . . . ..... . 
Running Applications . . . 
Removing Files to the Trash Can 
U sing a Terminal Window . . 

Copying Text. . . . . . . 
Resizing Window Contents . 

5. Getting Help 
How to Get Help . . . . . . . . . . . . . . . . 

Asking the Workspace Manager for the Help Index 
Choosing an Item from a 'Help' Menu 

The Help Menu Explained . . . . . . 
U sing a Help Menu . . . . . . . . . 

Clicking a [Help] Button in a Dialog Box. 
Getting Help on Help 

Using the Help Manager .. 
Viewing Help Text 
Displaying the Help Index 
Viewing More Than One Help Text at a Time 
Getting Status Information. . . . . . . . . 
Getting More Information . . . . . . . . . 
Getting Access to HP LaserRom Documentation .... 
Going Back and Forth Between Texts 
Searching for a Word . . ..... 
Searching for a Man Page 
Looking Up a Glossary Definition 
Printing Help Text . . . . . . 

4-7 
4-9 

4-10 
4-10 
4-10 
4-11 
4-12 
4-13 
4-14 
4-16 
4-16 
4-17 

5-2 
5-3 
5-4 
5-4 
5-4 
5-4 
5-4 
5-5 
5-5 
5-5 
5-6 
5-7 
5-7 
5-8 
5-9 

5-10 
5-11 
5-12 
5-13 

Contents-3 



6. Managing Your Files 
Getting a File Manager View . . . . . . 
What a File Manager View Tells You . . 

The Menu Bar with Pulldown Menus . . . . 
File Menu ... 
Directory Menu . 
View Menu ... 
Actions Menu 
Help Menu .. 

Status Line 
Host Name. . . ... 
Going Up the Directory Path. . 
The Meaning of "Files" and "Filtered" 

Display Area . . . . . . . . . . . . . 
Changing the Appearance of the Display Area 
Viewing a Large Directory . 

U sing the File Manager . . . . . . . . 
Selecting Files and Directories . . . . 

Selecting a Single File or Directory . . . . 
Selecting a Range of Files or Directories 
Selecting Files and Directories at Random 

Selecting and U nselecting With the View Menu 
Moving a File or Directory ... 
Copying a File . . . . . . . . 
Creating Files and Directories 
Finding a File or Directory. . 

Specifying the Scope of a Search 
Renaming a File or Directory. . . . 
Removing and Restoring a File or Directory . . . 
Changing File or Directory Properties . . . . 
Updating a File Manager View of a Directory 
Changing Directories . . . . . . 
Changing Your View of a Directory 
Saving File Manager Settings ..... 
Changing the Order of Files . . . . . 

U sing Actions ..... . . . . 
Default Actions . . . .. .... 
U sing the Actions Menu . 

Contents-4 

6-2 
6-2 
6-3 
6-3 
6-4 
6-5 
6-6 
6-7 
6-7 
6-8 
6-8 
6-8 
6-9 
6-9 

6-10 
6-10 
6-10 
6-11 
6-11 
6-11 
6-12 
6-13 
6-13 
6-14 
6-16 
6-17 
6-18 
6-18 
6-19 
6-21 
6-21 
6-23 
6-27 
6-28 
6-30 
6-31 
6-31 



Directory Actions . . . 
Data File Actions . . . 
Executable File Actions 

U sing Action Icons 
Locating Action Icons . 
Copying Actions 
Starting Actions Using Action Icons 

7. Tailoring Your Environment with Style 
Opening and Closing the Style Manager 
Getting Help on the Style Manager 
Changing Workspace Colors 

Modifying a Color Palette 
Adding a Palette . . . . . . . 
Deleting a Palette. . . . . . 
Restoring a Palette . . . . . . 

Changing Font Sizes .. 
Changing Workspace Backdrop Patterns 
Modifying Your Keyboard's Behavior 
Modifying Your Mouse's Behavior ... 
Adjusting Audio . . . . . . . . . . 
Specifying Screen Saver Time Out Intervals 
Allowing Hosts to Show Information on Your Workstation 
Specifying How You Want Your Next Session to Start 

Your Current and Home Sessions .. 
Choosing Which Session to Return To . . . . . . 

8. Advanced Customizing 
Watch Out for These "Gotchas" ..... 
Adding Resources to the Resource Database 

Using RES_EDIT to Change Resouces .. 
Using 'xrdb' to Change Resources . . . . 

Customizing the Workspace Manager Layout 
Getting a vuewmrc File . . . . . . . . 
Understanding the Workspace Manager Syntax . 
Workspace Manager Examples . . . . . . . 
Removing a Control from the Workspace Manager 

6-31 
6-31 
6-32 
6-32 
6-32 
6-34 
6-34 

7-2 
7-3 
7-4 
7-6 
7-8 
7-9 

7-10 
7-10 
7-12 
7-14 
7-15 
7-17 
7-18 
7-20 
7-22 
7-23 
7-24 

Adding Applications and Indicators to the Workspace Manager 

8-2 
8-2 
8-3 
8-3 
8-4 
8-4 
8-5 
8-5 
8-6 
8-6 

Contents-5 



Creating an Application Bitmap ........ . 
Adding an Application to the Workspace Manager 

Adding and Removing Workspaces 
Customizing Your HP VUE Menus . . . 

Understanding Menu Syntax . . . . . 
Adding or Removing Items from Menus 
Making Your Own Workspace Menus . . . . 

Creating Your Own File Types and Action Definitions 
Examples of File Types and Action Definitions 
Examining the System Files 
Modifying an Action .... 
Creating Your Own File Types 

Syntax for File Types . . . . . . . 
Choosing a Good File Type Pattern. 
Creating a File Type Definition . . . 

Creating Your Own Action Definitions. 
Syntax for Action Definitions . .... 
Creating an Action Definition 
Examples ........ . 

Customizing Mouse and Key Bindings . . 
Understanding Mouse Button and Key Binding Syntax 
Customizing Mouse Button Bindings .... 
Customizing Key Bindings . . . . . . 

A. The Vuepad Editor 
Starting'vuepad' . . . . . . . . . . . 

Starting 'vuepad' Using Its Icon 
Creating Copies of the 'vuepad' Icon .... 

The 'vuepad' Window 
Opening Documents. . . . . . . . . . 
Entering Text ....... . 

Turning OnlOff Word Wrap 
Starting aNew Paragraph . . . . . . 
Moving the Cursor . . . . . 
Scrolling the Tablet Contents. . . . . 

Editing Text ...... . 
Character Editing. . . . 
Selecting a Block of Text . 

Contents-& 

. . .' 

8-6 
8-7 
8-8 

8-10 
8-10 
8-10 
8-12 
8-13 
8-13 
8-13 
8-14 
8-15 
8-15 
8-16 
8-17 
8-18 
8-18 
8-21 
8-22 
8-23 
8-24 
8-24 
8-25 

A-I 
A-I 
A-2 
A-3 
A-3 
A-4 
A-5 
A-5 
A-6 
A-7 
A-7 
A-7 
A-8 



Moving, Copying, Removing, and Clearing Text. . 
Undoing an Edit . . . . . . . . . . . 
Searching For and Replacing Text . . . . . . . . . 
Including a File in the Current Document . . . . . 
Formatting the Document . . 
Running the Spelling Checker 
Printing the Document 
Saving the Document . . . . 
U sing the Open and Include Dialogs. . 
Making Vuepad Your Default Editor Action 

Glossary 

Index 

A-8 
A-9 

A-IO 
A-IO 
A-II 
A-12 
A-12 
A-13 
A-14 
A-15 

Contents-7 





1 
About HP VUE 

Are You Ready? 

II Is your workstation hardware properly set up and running, and is HP VUE 
installed on your workstation? 

III Are you familiar with a text editor? The vuepad editor included in HP VUE 
is described in Appendix A. 

II Are you administering a system or customizing your HP VUE environment? 
If so, then you will need the HP Visual User Environment System 
Administration Manual (HP part number Bl171-90044). 
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An Overview of HP VUE 
If you're not quite sure how the HP Visual User Environment (HP VUE) 
fits into your workstation "picture," read on; otherwise, skip the rest of this 
chapter. Chapter 2 provides you with a 20-minute tutorial; the chapters after 
that provide task-related information. 

Your Workstation and HP VUE 

Think of your workstation as a large corporation. Like a large corporation, 
your workstation has different levels of organization, each with its assigned 
duties. 

The workstation hardware does all the processing-the computing-in the 
system processing unit (SPU), stores data and programs on the disk drive, 
and provides you with input devices (the keyboard and mouse) and an output 
device (the display) .. Your workstation hardware takes orders from the 
operating system-the software commands that control how the hardware 
processes data. 

The operating system, it turn, takes orders from the X Window System (X), an 
industry standard set of software commands that provides both the "windows" 
on your display and the common language through which applications from 
different places can talk to each other. X, for its part, takes orders from 
HP VUE. HP VUE is the user interface. It draws a graphical layer over 
the complexities of the rest of the organization, enabling you to control your 
workstation by directly manipulating graphical "objects" instead of by typing 
commands at a command-line prompt. 

About HP VUE 1-3 
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A Look at HP VUE 

~ 
ICON 

11 1 Uay 30 chadief@hpcv:xcf (25) lIP 
H 2 tfay 30 kreta@hpcv:xkk (54) lIP 
11 3 tfay 31 patti@hpcv:xper (17) lIP 

. Command: • 

• 111. 
Color Fonts 

May 25 .&.lU. 
Fri _ 
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2 

3 

:F-::? 
6 

7 

8 
9 

1. Terminal Emulation Window (Chapter 4). 6. Help Manager Index (Chapter 5). 
2. Window Icon (Chapter 4). 7. File Manager (Chapter 6). 
3. Electronic Mail (Chapter 4). 8. Logout Confirmation Dialog Box (Chapter 3). 
4. Rename Workspace Dialog Box (Chapter 4). 9. Pointer. 
5. Style Manager (Chapter 7). 

A Tutoria 
Applicati 
Creating 
Glossary HP VUE Ve 

10. Workspace Manager (Chapter 4). 

HPVUEVel~============================================~11 Help on t 
How to Wr !iii !iii 

admin control gr~phics runawk 

Logout Confirmation 

style03.1 )7.b 

~ 
style08.1 

Beginning logout process .•• 

! Some applications may not be saved. 

Continue? 
p.b 

::·3~ ~ x ,. 
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1 

The Six HP VUE Managers 

Your workstation is a large organization, and you're the boss. The components 
that make up HP VUE are your management team, each dedicated to 
controlling specific functions. 

Login Manager The login manager heads your security force, allowing only 
authorized personnel to enter your workstation's file structure. 

Session 
Manager 

Workspace 
Manager 

File Manager 

Style Manager 

The session manager is in charge of the crew of software 
programs that set up your work session. Coming in early and 
leaving late, the session manager is seldom seen, but always on 
the job, ensuring everything runs just the way you like. 

The workspace manager is your chief of staff, attending to the 
operation of the workspaces and the myriad of tasks that occur 
during every work session. 

The file manager handles the physical organization of your file 
structure, performing file management tasks and making your 
life as boss easier. 

The style manager takes care of the routine workspace 
maintenance, perhaps repainting a workspace in a different 
color, or speeding up the mouse double-click time on Monday 
(or slowing the mouse down on Friday). 

Help Manager The help manager controls the reference library and access to 
information about HP VUE and its components. 

HP VUE and Applications 

To operate at its full potential, an application needs to talk to the HP VUE 
managers. Depending on the application, it may be able to talk to all the HP 
VUE managers, or just a few. 

For more information on HP VUE and applications, see "Running 
Applications" in chapter 4 and "Creating Your Own File Types and 
Action Definitions" in chapter 8. For the full story, see the HP Visual User 
Environment System Administration Manual (HP Part No. Bl171-90044). 

That's all the background you need to operate the HP Visual User 
Environment. Now, experiment, experience, and enjoy! 
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Using HP VUE Tutorials 
There are two types of tutorials for HP VUE: 

• Chapter 2 contains printed tutorials . 

• The HP VUE Help Manager contains on-line tutorials. 

Both types of tutorials guide you through typical HP VUE activities. You can 
use either or both. 

To start working through the on-line tutorials: 

1. First, examine the first five printed tutorial modules in chapter 2. They 
introduce the mouse and keyboard, explain how to manipulate windows, and 
show you how to log in. 

2. Click the help button in the workspace manager. 

-_u -I .1:= =~=:u=er ===:II~! =:=:==:11 ~ =T:=:=e ~I'II., 
~: 1 .... _~=gij .. Q-~ 

Click to open the Help Index --.J 

3. Click the [Viewer] button in the Help Index Window. If necessary, move 
the Help Viewer window out of the way of the Help Index window. 

4. Click A Tutorial for New Users in the Help Index window. 
5. Read the text in the Help Viewer window. 
6. Continue through as many of the on-line tutorials as you'd like. 

About HP VUE 1-7 
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Where to Find Additional Information 

To order any of the manuals listed here, call: 

• HP Direct at 1-800-538-8787 . 
• Your HP Sales Representative. 

and ask for the part numbers listed for the manuals. 

The following books provide additional information about HP VUE. 

To Learn More About ... 

Preliminary configuration and 
updating to HP VUE 2.01 on 
HP-UX 7.* systems. 

Preliminary configuration for HP 
VUE on HP-UX 8.* systems. 

Preliminary configuration for HP 
VUE on other operating systems. 

Administering and customizing the 
HP VUE environment. 

Writing applications for HP VUE 

Running the X Window System 
without HP VUE; reference pages 
for the X Window System 

1-8 About HP VUE 

Read ... 

HP Visual User Environment 
Installation Guide 

HP Visual User Environment 
Configuration Guide 

HP Visual User Environment 
Configuration Guide for your 
operating system. 

HP Visual User Environment 
System Administration Manual 

HP Visual User Environment 
Programmer's Guide 

Using the X Window System 

Part 
Number 

Bl171-
90006 

Bl171-
90041 

Bl171-
90044 

Bl171-
90024 

Bl171-
90043 



These books provide additional information about the OSF /Motif environment, 
the X Window System, widgets, and widget programming: 

OSF /Motif Style Guide 

OSF /Motif Programmer's Reference 

OSF /Motif Programmer's Guide 

The X Window System: OSF /M otif Edition 

Mastering OSF /M otif Widgets 

Bl171-90032 

Bl171-90033 

Bl171-90034 

ISBN 0-13-497074-8 

5010-7168 

The following books about the X Window System and OSF /Motif are also 
available: 

II Introduction to the X Window System by Oliver Jones. Prentice Hall, 
Englewood Cliffs, NJ:1989. 

II The X Window System in a Nutshell. O'Reilly and Associates, Newton, 
MA:1990. 

.. Xlib Programming Manual for Version 11 by Adrian N yeo 0 'Reilly and 
Associates, Newton, MA:1990. 

III Xlib Reference Manual for Version 11 edited by Adrian Nye. O'Reilly and 
Associates, Newton, MA:1990. 

II\! X Window System User's Guide OSF/Motif Edition by Valerie Quercia and 
Tim O'Reilly. O'Reilly and Associates, Newton, MA:1991. 

.. X Protocol Reference ManualO'Reilly and Associates, Newton, MA:1990. 

II X Window Systems Programming and Applications with Xt by Douglas A. 
Young. Prentice Hall, Englewood Cliffs, NJ:1990 . 

.. OSF/Motif User's Guide. Prentice-Hall, Englewood Cliffs, NJ:1990 . 

.. Advanced X Window Applications Programming by Eric F. Johnson and 
Kevin Reichard. MIS Press, Portland, OR:1990. 
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2 
Getting Started 

The first few modules in this chapter show you some basics, and the rest walk 
you step-by-step through an HP VUE session, from login to logout. Stepping 
through the modules should take around 20 minutes. If you need to stop, 
follow the steps in the last module, "Logging Out." 

Your workstation's speed and memory determine how fast actions are 
performed. If you don't see a window open immediately, for example, wait a 
few seconds! 

2 



2 Module 1: Using a Mouse 

2 (Both buttons 
~multaneOUSIY). 

1 3 

To click: press and release a mouse button quickly (usually mouse button 1). 
To double-click: press and release a mouse button twice quickly (usually mouse 
button 1). 

To move the pointer: To drag an object: 
Move the mouse. 1. Move the pointer over the object. 

2. Press and hold down the mouse button. 
3. Move the mouse. 
4. Release the mouse button. 

2-2 Getting Started 



Module 2: Recognizing Pointer and Cursor Shapes 2 

Pointers (Mouse) Cursors 
(Keyboard) 

Working: :IiI Inserting: 0"---1 r:"_N_] r--I 

Moving: + Selecting: m .: .....• 
l~! 

Pointing: ~ X 

Resizing: ~ 'i' ;il 1+ ~ ~~ ~ 

Help: ~ 

Grabbing: + 
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2 Module 3: Working with Windows 

To make a window active: 

'1 

--- Click anywhere on window. 

To use window buttons: 

To move a window: 

Click to show window menu. 
Double-click to close window. 

'1f====5~~~=:E~~~i"---1. Move pointer over ~ T 1.1 I title bar. 

~bJ 
'1 

I..!::J:=:I======E' Cu" •• , Locatio. 
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2. Press and hold 
down mouse 
button 1 or2. 

-,--3. Drag window to a 
new location. 

4. Release mouse 
button. 



To resize a window: 

xl 

To shuffle windows: 

To use a scroll bar: 

1-. 

--

~ xl 

xl 

1. Press and hold down 
mouse button 1 or 2 
on window frame. 

2. Drag window frame 
to new size. 

3. Release the mouse 
button. 

H 

L Click concealed window to shuffle to top. 

~r Click to go up one line. 

~III Click to go up one page. 

L Drag slider to move 
incrementally. 

Getting Started 2-5 
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2 Module 4: Logging In 
To start HP VUE, you must identify yourself as a valid user by typing your 
login name and password (if any). 

If you do not have a login and password, ask your system administrator for a 
login account. 

1. Type your login. 
2. Press (Enter ]. 

ft3 HEWLETT 
~""IPACKARD 

I_, __ ~,~:,!~;;:;~;;:::~~::;::::;:;;;:;:;::::.:;:::~;;;:;~JI 
I~~,~"~:"R:::;;;::;;:;::;:::~:;:::~;,-~w,~'w."w,-,j I 

3. Type your password (if any). Your password is secret and does not appear. 
4. Press (Enter] or click [OK]. 

If you mistype your name or password, a dialog box opens letting you know the 
login was incorrect. If this occurs, point to the [OK] button in the dialog box 
and click mouse button 1. 

To edit the Login text entry box, see the Tips below or click [Clear] and start 
again. 

Tips To edit a text entry box such as the Login box, click the box 
to display the insertion cursor, then use (Backspace ], (Delete char ], 

(Insert char ], or left and right arrow keys. 
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Your first workspace should look similar to this: 
2 

Console Window Icon 
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2 Module 5: Renaming a Workspace 
HP VUE comes with six workspaces, which is like having six separate displays 
on which to organize your work. Each workspace must have a unique name. 

1. Move the pointer over the Rename Workspace button in the workspace 
manager. 

2. Click mouse button 1 to open the Rename Workspace dialog box. 
3. Move the pointer over the text entry box to the right of Workspace. 
4. Double-click mouse button 1 to highlight the name and display the text 

insertion cursor. 

c::>1 Rename Workspace 

-_. _,1:=1 =;=:u=er ~I :=1 =;=:=~II:= =T:=:=e ~IIII ~ I 
... : 1~ __ !!¥=!4".-!iii: 

E Click to open the Rename Workspace dialog box. 

5. Type Main. The word One is erased as you type. 
6. Press (RetUffi) or click [OK] to rename the button in the workspace manager 

and close the Rename Workspace dialog box. 

Tips 

" 
Once logged into HP VUE, you can edit a text entry box, like 
the one for a new workspace name, by: 

• Dragging to highlight characters. 
• Double-clicking to highlight a word. 
• Triple-clicking to highlight all words. 

Once highlighted, characters or words. are replaced as you type. 
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Module 6: Switching Workspaces 

1. Move the pointer over the Two button in the workspace manager. 
2. Click mouse button 1 to switch to your second workspace. 

Module 7: Opening the Style Manager 
You can use the style manager's dialog boxes to tailor your workspace to fit 
your needs and preferences. 

1. Move the pointer over the style manager button in the workspace manager. 
2. Click mouse button 1 to open the style manager. 

St 

File !!elp 

• •• Color Backdrop Keyboard 

'=;::r=====:1 ~I ;:====:. 1 ::=1 ~~=====:.. III ~ II ~ II ~ II D~ I 
siiij~~-~==ij~.-: 

L Click to open the Style Manager. 
j
l~ 

Progress light 1= 

To let you know HP VUE is working on your command, the progress light in 
the lowe:r; right corner of the workspace manager blinks, and your pointer turns 
into an hourglass (til) while over the workspace manager. 
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2 Module 8: Changing a Workspace Backdrop Pattern 
You can choose a backdrop for your workspace from a list of patterns in the 
Backdrop dialog box. To make a workspace easy to recognize, you can choose a 
different pattern for each workspace. 

1. Click the Backdrop button in the style manager to open the Backdrop 
dialog box. 

2. Click BrickWall in the list to display this pattern in the viewing area. 

r~',.' r,'.!'~"m."',. r,".' rllmi" rl!!]>,-.""""~'~~"v~ 
i '~""" ,;...-, 

i Fonts ! Backdrop ! Keyboard 1 Mouse 1 Audio 

, '-I:: CIiC'k to open t~e BaCkdrop'dialOg box. 

3. Click [Apply] to fill the workspace background with the pattern. 
4. Click [Close] to close the Backdrop dialog box. 
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Module 9: Changing Workspace Colors 
You can change workspace colors by selecting a palette in the Color dialog 
box. The selected palette is used for all workspaces. Because display type 
determines colors and palettes available, the Color dialog box shown in this 
module may be different from the one on your display. 

1. Click the Color button with mouse button 1 to open the Color dialog box. 
2. If you have a color display, click Dierra in the Palettes list to change 

workspace colors. If you have a black and white (monochrome) display, click 
Whit eBlack. 

Color 

Palettes------------. 

CoralReef ; ~i ; Dakota ! -' 
Dalla ! ' 
'ill$4I ! j 
Equinox J~ ! 
~~~!!W"~~'~~"h'N~_ i; 

File 

3. Click [OK] to close the Color dialog box. 

r~'Fidd::':"'-'"""1 

r~~~.~J 

!!elp 

•• Hosts Startup 
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2 Module 10: Choosing from a Menu 
In HP VUE, all menus work the same: 

1. Move the pointer over a menu name in the menu bar-for example, File in 
the Style Manager. 

2. Click mouse button 1 to display the menu. 
3. Click your menu choice-for example, Exit. 

Tips Other ways to choose from a menu: 

• Dragging through a menu. 

1. Move your pointer over the menu name. 
2. Press and hold down mouse button l. 
3. Drag through the menu items until your choice highlights. 
4. Release mouse button 1. 

• Using a mnemonic key, an underlined character in a menu 
item. For example, the "H" is the mnemonic in the On 
Help ... item in the style manager's Help menu. A menu 
must be displayed to use a mnemonic. 

1. Move your pointer over the menu name. 
2. Click mouse button 1 to display the menu. 
3. Press the mnemonic key on the keyboard to choose the 

item, for example ® to choose On Help .... 

• Using accelerator keys, a sequence of characters. The 
menu doesn't have to be displayed to use an accelerator. 
Accelerators are listed to the right of some menu items, for 
example, <Ctrl>H in the style manager's Help menu. 

1. Click the window to make it active. 
2. Press the character sequence to choose the item, for 

example, [CTRL] ® to choose On Help... without 
displaying the menu. 
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Module 11: Opening and Closing a Terminal Window 

1. Click the terminal button to open a terminal window. 

Window Menu 
Button 

~ 11~=::=:r ~II::= =::====:I ::=1 =T::=e ===:111'., 
~: l!i __ ~.==ij~~_!!if 

ECIiCk to open the Terminal Window. 

2. Press (Return) to redisplay the command-line prompt, which may be a "'/.," a 
"$," a ">" or another special character. 

3. Double-click the window menu button to close the window. 
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2 Module 12: Opening the File Manager 
Manage the information you store in your workstation with the file manager. 
Your workstation uses files to hold data. Directories are "folders" that hold 
files and other directory folders. 

1. Click the file manager button to open the file manager. 

Menu Bar 

Status Line 

Directory -~:-liii::iiiI 
Icon 

Note 

Memos Readme 

Display Area 

.=;:~:: ::e II~II ~ 11.11[1~11 
j~.!=!ij"'._: ;1 

Click to open the File Manager. J 
Your workstation shows different files than those pictured. The 
file manager displays your home directory, the directory in 
which you are placed after you log in. 
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Module 13: Creating a Directory 

1. Choose New... from the Directory menu to open the New Directory 
dialog box. 

2. Click the New Directory Name box to display the text insertion cursor. 

New Directo 

New Directory Name: I 

Show File Type 

3. Type Abe. 
4. Press (RetUrn) or click [OK]. 

Note 

" 
File or directory names must be single words, containing no 
spaces or tabs, and unique to the directory in which they are 
contained. 
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2 Module 14: Opening Another File Manager 
You can open another file manager that shows a different directory's contents. 

1. Move the pointer over the Abe directory icon. 
2. Press and hold down mouse button 2. 
3. Drag the Abe directory over the workspace background. 

a------
Abe 

4. Drop the directory (release mouse button 2). 

Tips Other ways to open a file manager: 

• Click the file manager button in the workspace manager. 
• Click a directory icon, then choose Open New View from the 

file manager Actions menu. 
• Drag and drop the current directory icon (located in the file 

manager status line) over the workspace background. 
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Module 15: Creating a File 
You can use the file manager to create a new file in a directory. 

1. Choose New ... from the File menu in the luserslYourHome/Abe file 
manager to open the New Data File dialog box. 

2. Click the New Data File Name box. 

£opyAs ... 

~ropertie~ ... 

Find ..• 

!.ra~h File(s) 

Show Trash ... 

3. Type Ace. 

4. Press (RetUT) or click [OK]. 

NewOata File 

III 
~ 
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2 Module 16: Copying a File 

1. If your two file manager views overlap, move the Abe directory view below 
the original view so you can see their display areas. 

2. Move the pointer over the Ace file in the Abe directory view. 
3. Press and hold down ( CTRL ). 

4. Press and hold down mouse button 2. 
5. Drag the Ace file over an empty area in the original view's display area. 

Original view 

liii liii 
Abe Memos Readme 

6. While still holding down (CTRL ), drop the file (release mouse button 2). If 
you release (CTRL) before mouse button 2, the file is moved instead of copied. 

7. Release (CTRL ). 
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Module 17: Renaming a File 

1. If your original view's display area contains many files and directories so 
that Ace does not appear at first, drag the scroll bar's slider down until Ace 
shows in the display area. 

2. Click the Ace file in the original view. 
3. Choose Rename ... from the File menu to display the Rename File dialog 

box. 

£opyAs ••• 

~roperties ••• 

,Find ••• 

Readme 

!rash Filees) 

Show Trash 

Rename File 

Current File Name: Ace 

New File Name: Ace 

Show File Type 

4. Double-click the New File Name box. 
5. Type Age. 
6. Press (Return) or click [OK]. 

Getting Started 2-19 

2' 



2 Module 18: Moving a File 

1. Press and hold down mouse button 2 on the Age file in the original file 
manager. 

2. Drag the file to the Abe directory file manager display area, ensuring that it 
is over an empty area. 

!iii 
Abe Memos Age~ . . , , , 

1]1¥' 
AlA 
=r=; 

Readme 

Original view 

~ ___ "~"'_A~"'_"~·_~~_."~. ilr====;:~ =========================~II 

Ace 

, , 

I 

3. Drop the file (release mouse button 2). 
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Module 19: Removing a File 

1. Press and hold down mouse button 2 over the Age file in the Abe directory 
view. 

2. Drag the file over the trash can. 

Ace Age ... 

.... 

I 

I 

I 
! 
1 
! 
l 

., ...... ·~.w.,·.· ... · ......... w.·.w ... •.• ... w ................. ,·., ......... 'w ....... ,· ..... ·.,·.·.·.·~.·.·.·~ ........ ·.·.w.w.·"..., .... w.·.w.· ........ w ... • ......... w.· ............................... w ............ w .................................. WN ........................ "'w.w ..................... , ............... : .• ~ ... ~ ""'.--;;. ............ ~~ .................. w ........... w ................ u.v ....... ~ ..... w •. ~ ........ j 

.. =. 

3. Drop the file. The file is removed from the file manager display area. 

You can also remove a file by clicking it with mouse button 1, then choosing 
Trash File(s) from the file manager's File menu. 

Caution , You can restore files or directories for a limited time only. They 
will be permanently removed when you log out. 
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2 Module 20: Restoring a File 

1. Click the trash can in the workspace manager to open the Trash Can 
window. 

2. Click the /users/ YourHome/ Abe/ Age file name in the Trash Can list area. 

hpcvxper: /users/patti/AlJe/Age 

kI' 

Click the trash can. ~===iI 

.=;:~II~! :==::"" III~I_ ~ .I[~I 

3. Choose Restore from the Trash Can window's Edit menu. The file is 
restored in the file manager display area. 

4. Choose Exit from the Trash Can window's File menu. 

Restored files are returned to the directory from which they were removed. 

Caution 

I 
You can restore files or directories for a limited time only. They 
will be permanently removed when you log out. 
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Module 21: Finding a File 
You can search your directories to find specific files or groups of files with 
names that have characters in common. 

1. Choose Find... from the File menu in the Abe directory view to display 
the Find Files dialog box. 

2. Click the File Name box to the left of the /1*/1 to display the text insertion 
cursor. 

3. Type sys. in the box, so that the contents of the box is sys .*. The * 
stands for "any sequence of characters." Thus, the target of the search will 
be files that have names starting with sys .. 

4. Click the Search Directories box and remove the"." (period). 
5. Type /usr/lib/Xll (that's "X one one," not "X el el"). 
6. Click [Start] in the dialog box to list all files that begin with "sys.". The 

files found are preceded by their complete directory path. 
7. After the files show in the Files Found box, click [Close]. 

Find Files 

Size (In K bytes) Dates (mm/dd/yy) 
r-----~ 

Smaller Than: L~,w" __ ~w,."_",,"~_,,,," Modified Before: I J 
a....-.. •. ,."w.·.'w. __ ,_.wdi 

larger Than: I 
',~_w"",w_""."u ... ·~,,,,_~·,,·,.,"_N_J 

Files Found: 

/usr/lib/Xll/sys.Xdefaults ~ Vl~-l 
/usr/lib/Xll/vue/Vuesession/sys.resou 
/usr / Ii b/Xll /vue/Vuesessi on/ sys . sessi f"w,""v'WW __ UN""",,,,,,,,,,,,ww-1 

/usr / Ii b/Xll /vue/Vuesessi on/ savel sys. ; New Vlew 
/usr/lib/Xll/vue/Vuesession/save/sys. ' 
/usr/lib/Xll/vue/Vuewm/sys.vuewmrc 

@ M 
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2 Module 22: Going Up the Directory Tree (Hierarchy) 
You can go up in your directory tree to view a "parent" directory folder, a 
directory containing the current directory. 

1. Double-click the YourHome segment in /users/ YourHome/ Abe in the file 
manager's status line. 

Ace Age 

Your two file managers should now be identical. 

2. Exit one of the file managers by choosing Exit from its File menu. 
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Module 23: Removing a Directory 
As with files, you can remove directories, but be careful. When you remove a 
directory, any files or other directories it contains are removed a.lso. 

1. Drag the Abe directory over the trash can . 

..=;:=::I~I ::~. I'II~ II ~ II ~ trg 
2. Drop the directory. If the directory is not empty, a warning dialog box 

appears. Click [OK] if you want to remove the directory. 
3. Close the last file manager view. 

Caution , You can restore files or directories for a limited time only. They 
will be permanently removed when you log out. 
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2 Module 24: Opening the Help Manager Index 
You can get an index to topics on which you can get on-line help. 

1. Click the help button to open the Help Index window. 

Tips 

" 

File !!.elp 

Introducing HP VUE Online Help Lines: 1 to 8 of 12 

A Tutorial for New Users 
Application Information 
Creating Your User Environment 
Glossary 
HP VUE Version & Copyright 
HP VUE Version 2.e1 Release Notes ' 
Help on the Workspace Manager I 
How to Write Online Help :Z 

IN'~~~;"I;;~I;~~ Pmvious Ind(~x fT~;;;I~~I;;] rVi;;"u;~] 

r"'-Vi;;;;""",] r""'b'~"'~"""'S'h;;;'S";;;~hO;tl~~'"~'''''U'''V""] 

~ 1:=:1 =;:=:r ===:11:=:j =::====:1 :=:1 =T::=e ===:1111., 

~I I""'_g==ij"~ __ 
Click the help button to open the Help Index. ---1 

• Choose On Application. .. from a window's Help menu to 
get information about that window. 

• Click the [Help] button in a dialog box to get information 
about that dialog box. 
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Module 25: Selecting and Viewing a Help Topic 

1. Click A Tutorial for New Users in the Help Index's list of topics. 
2. Click [Viewer] to open the Help Viewer window that displays the 

information. 

Introducing HP WE Online Help 

A Tutorlal for Hew Users 
Application Information 
Creating Your User Envirom 
Glossary 
HP VUE Version & Copyright 
HP VUE Version 2.01 ReleaSE 
Help on the Workspace Manal 
How to Write Online Help 

Lines: 1 to 15 of 28 

WeICC*e to the IF VI£ tutorial. 

Use the scroll bar on the right when there's too 
IIUCh text to fit in the display area at one tille. 

To IIIO\Ie the text up one line: 

1> Put the .ause pointer arrow on the downward 
triangle at the botto. of the scroll bar. 

2) Click (press and release) .ause button 1 (the 
JIOUSe button ..... yotr index finger). 

Try it now so you can read the rest of this text. 

I 
I 

.~----' J 
Snapshot 
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2 Module 26: Making a Copy of Help Text 
You can keep help information handy on your workspace by t~king a 
"snapshot" of the Help Viewer window. 

1. Click the camera in the Help Viewer window to take a "snapshot" copy of 
the help text. 

A Tutorial for New Users Lines: 1 to 19 of 83 

Welcome to the HP VUE tutorial. I 
! 

Use the scroll bar on the right when there's tool 

::c:O::x:h:ot::: :: ::: :::::ay area at one timel 

1) Put the mouse pointer arrow on the downward l 
triangle at the bottom of the scroll bar. i 

2) Click (press and release) mouse button 1 (the 
mouse button under your index finger). 

Try it now so you can read the rest of this text 

Good job! Do it a few more times and read on. 

When you click the downward triangle, notice the 
scroll bar's slider moves downward. The slider 

Search For. 

2. Click [Close] in the Help Snapshot dialog box. 
3. Close the Help Viewer window using the File menu. 
4. Close the Help Index window using the File menu. 
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Module 27: Logging Out 

At the end of your work session, log out to return to the login screen. 

1. Click the logout button (the ribbed area surrounding the progress light) to 
begin the logout process. 

Logout Confirmation 

Begiming logout process ••• 

! 
S<*e applications IIIa'4 need to be restarted after log in. 

Data not preYiousl~ saved IIIa'4 be lost. 

Continue? 

0 I Cancel I ~ 

E Click the logout button. 

2. Click [OK] in the Logout Confirmation dialog box to return to the login 
screen. 

Caution 

I 
In real working sessions, always save open data files before 
logging out. Some files, especially those for applications 
running in terminal windows, aren't saved by the logout 
process, and you will lose unsaved data. 
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3 
Managing Your Session 

Your session is the time between logging in and logging out. This chapter 
explains logging in, logging out, and the login options that affect your session. 

3 
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Logging In 
Unless your workstation has been reconfigured, the login screen should appear 
on your display whenever you are not logged into a work session. Think of the 
login screen as your starting point. 

Logging into an HP VUE Work Session 

Most of the time when you log in, you will want to start an HP VUE work 
session. 

To log in and start an HP VUE work session: 

1. Click the Login box. 
2. Type your login name. 
3. Press (ReWffi). 
4. Type your password. 
5. Press (ReWffi) or click [OK]. 

Logging into a Fail-Safe Session 

On occasion, logging in might not go as expected, and you are left at the login 
screen. 

When this happens, you can log into a "fail-safe" session. You can then use a 
terminal emulator window or an editor to correct the configuration problem. 
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To log into a fail-safe session: 

1. Click [Options]. 
2. Choose Fail-safe Session. 
3. Click the Login box. 
4. Type your login name. 
5. Press (ReiUT). 
6. Type your password. 
7. Press (ReiUT) or click [OK]. 

Logging in Without Windows (HP-UX Only) 

Occasionally, you may want to bypass HP VUE at login. When you log in 
without windows, a command-line prompt appears on the display, but no HP 
VUE and no windows. 

To log in without windows: 

1. Click [Options] on the login screen. 
2. Choose No Windows. 
3. Type your login name at the login prompt. 
4. Press (ReiUT). 
5. Type your password. 
6. Press (ReiUT). 

When you log out, the login screen will reappear. 

Correcting Login Mistakes 

To correct an entry, use the (Backspace ), (Insert ), (Delete char ), and arrow keys to 
edit the box. Or start the login over by clicking [Clear]. 
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Getting Help Logging In 

To get help logging in, click the login screen's [Help] button. 

The help dialog box that appears will refresh your memory. For more 
information, log in, then click the help manager question mark [1]. You'll 
find login information organized neatly under Applications/HP Visual User 
Environment/Login Manager. 

You can print a copy of any help text by choosing Print from the help viewer's 
File menu. 

Changing Languages 
You can change the language of your HP VUE session at login. 

To change the language of your session: 

1. Click [Options] on the login screen. 
2. Click Languages. 
3. Click the language you want. 
4. Login as usual. 

Why and How Often to Restart the X Server 
The X server is the program that handles communication between applications 
and your workstation display. Over time, the amount of space the server uses 
for memory may increase. Restarting the server releases this "borrowed" 
memory back to the workstation and returns the X server to its original size. 

To restart the X server: 

1. Click [Opt ions] on the login screen to display the Options menu. 
2. Click Restart Server. 

Once you've restarted the server (it'11 take a minute or so), the login screen 
reappears an~ you can log in as usual. 
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How often you restart the X server depends entirely on the applications you 
use. If your applications don't require the server to borrow memory for them, 
you may never have to restart the server. As a guideline, if you notice the 
performance of your workstation getting slower, restart the X server. 

Securing Your System 
While computer viruses garner their share of the news, less exotic security risks 
are potentially just as damaging. For instance, if you don't log out or lock up, 
any passerby can take over your keyboard, view your personal data files, and 
copy or print sensitive information. 

The following table lists some common sit"Q.ations and how to eliminate security 
risks: 

Hyou ... You should ... 

Need more security than just a login Create a password using the Password 
name. application. 

Briefly leave your workstation. Lock up by clicking the workspace 
manager lock. 

Leave your workstation for a long time. Log out by clicking the workspace 
manager logout button. 

Want to restrict remote access to your Delete unnecessary host names from your 
workstation. access list using Hosts in the style 

manager. 

Think your password isn't secret. Change your password using the 
Password application. 

Creating and Changing Your Password 

Your password is a secret countersign known only to you and your workstation. 
You should create a password for yourself when you or your system 
administrator create your user account. 

The requirements for a valid password depend on the operating system your 
workstation is running. 
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For HP-UX: 

• The password must contain at least six characters. 
• At least two characters must be alphabetic. 
• At least one character must be a number (0-9) or a special character (/, ?, !, 

or other punctuation mark). 
3 • A new password must differ from your previous password by at least three 

characters. 
• The password is case-sensitive, so ?Secret is different from ?secret. 
• The password can also be as long as you want, but only the first eight 

characters are checked. 

For other operating systems, consult your system administrator. 

To create or change a password: 

1. Click the applications directory button on the workspace manager to display 
the applications directory. 

2. Double-click the system_apps folder to open that subdirectory. 
3. Double-click the sys_admin folder. 
4. Double-click the PASSWORD icon to start that application. (The application 

is different for different operating systems. Follow the procedure for that 
application. ) 

Locking and Unlocking Your HP VUE Session 

If you leave your workstation unattended, you don't have to log out. You can 
lock your session by clicking the lock icon on the workspace manager. To 
unlock your session, type your password and press (RetUffl). 
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Displaying the Copyright Message 
You can display a copyright message for HP VUE from the login screen. 

To display the copyright message: 

1. Click [Options] on the login screen. 
2. Click Copyright. 

To remove the copyright message, click [OK] at the bottom of the copyright 
dialog box. 

Logging Out 
Before logging out, always save open data files. Data from some applications, 
as well as some applications themselves, cannot be saved by the logout process 
(because they don't talk to the session manager). 

Caution , Unsaved data, especially from applications running in terminal 
windows, isn't saved by the logout process and will be lost! 
Some applications may need to be restarted. 

Managing Your Session 3·7 

3 



3 

To end an HP VUE session, click the logout button on the workspace manager 
or choose Log out ... from the workspace menu (Press mouse button 1 with 
the pointer over the workspace backdrop). 

Workspace Menu 

Shuffle Up 

Shuffle Down 

Refresh 

Toggle Workspace Manager 

Restart Vuewm ••• 

Log out. •• I.....J 
1~1 ~ II.~I]~~ 

E Click he .. to log out.. . .. or drag the Workspace Uenu =I 
and choose "Log out. .. ". 

Confirming Your Logout 

Depending on the settings in the style manager's Session Startup dialog box, 
a confirmation dialog box may appear asking you to confirm that you want to 
logout. 

Click the dialog box's [OK] button to confirm logging out. Click [Cancel] to 
avoid logging out. 

Restarting or Restoring Your Session 

Alternatively, a query dialog box may appear asking you whether you want to 
restart the current session or restore the home session at next login. 

Restarting means that, the next time you log in, the session that appears is the 
previous session (minus applications in terminal windows). Think of restarting 
as beginning where you left off. 

Restoring means that, the next time you log in, the session that appears is the 
session you previously designated as your "home" session in the style manager's 
Startup dialog box. Think of restoring your session as beginning every session 
at the same place, no matter where you leave off. 
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Click [Restart Current] to begin your next session where you left off this one. 
Click [Restore Home] to begin your next session with your home session, your 
preferred starting place. 

See "Specifying How You want Your Next Session to Start" in chapter 7 for 
more information. 

Canceling a Session 
At some time or other, it may be necessary for you to cancel a session without 
using the normal HP VUE logout procedure. For example, this could happen if 
you made a mistake while trying to customize your system (this is covered in 
chapter 8) and somehow deactivated both the logout button in the workspace 
manager and the Log out . .. button in the workspace menu. 

To cancel a session: 

1. If possible, close all your terminal emulator windows. 
2. Perform the appropriate server reset procedure for your system. Generally, 

for HP-UX systems, hold down (Shift) and (Ctrl] and press (Reset). For other 
systems or keyboards, check the appropriate documentation for resetting the 
server. 

The system will return to the login screen without saving your current session. 

Shutting Down the System 
Procedures for shutting down your workstation are covered in the HP Visual 
User Environment Configuration Guide. 
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Managing Your Workspaces 

This chapter covers managing your HP VUE workspaces through direct 
manipulation. 
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Using the Workspace Manager 
The workspace manager provides a central location for indicators and 
frequently required functions, typically information and services you require in 
every workspace. 

Reading Workspace Manager Indicators 

The workspace manager, sometimes called the "front panel," contains the 
following indicators: 

Clock 

Date 

Load 

Displays the current workstation time. 

Displays the current workstation date. 

Indicates how hard your workstation is working. 

Progress Light Blinks to indicate an activity in progress, typically an 
application starting or window opening. 

Clicking the progress .light begins the logout process. Clicking the other 
indicators has no meaning. 

Clock Date Load 

I I I [Q]~~.25 .AM ~ ~ Fn :.=: 

I arl~~~ , , 
I 

Progress 
Light 

To modify workstation time or date, see the HP Visual User Environment 
Configuration Guide. 
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Starting Workspace Manager Services 

The workspace manager comes with a selection of services. 

Mail 

Workspace Switch 

Print 

File Manager 

Applications Directory 

Trash Can 

Terminal Window 

Style Manager 

Rename Workspace 

Lock 

Help Manager 

Logout Button 

Displays a dialog box for specifying a mail 
destination when you drop a file icon on the 
mail icon. Starts the elm electronic mail 
program on HP-UX systems. 

Switches workspaces. 

Prints a file when you drop that file icon on the 
print icon. 

Starts a file manager view of your home 
directory. 

Starts a file manager view of applications 
available on your workstation. 

Removes a file when you drop the file icon on 
the trash icon. 

Starts a terminal window, providing access to 
the command-line prompt. 

Starts the style manager. 

Displays the dialog box you use to rename your 
workspaces. 

Locks your workstation screen, preventing 
keyboard and mouse input. 

Starts the help manager. 

Begins the logout process. The progress light is 
part of this button. 
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Application 
Directory 

Workspace I Switch Print File Trash 

Ma=iI~~~~~'~;;;;;§~=Wager Can 

1rr===::19::==iJ=~~i25=r=IM==;;==1 cb J :atiii~~~T~lI 
I. I I Lock II Progress Light :I I Terminal I 

Window Rename 
Workspace Logout 

Style Help Button 
Manager Manager 

4 To start any service, click its button on the workspace manager. The progress 
light starts blinking. 

Clicking the button for the file manager gives you a new file manager view 
each time you click. Clicking the terminal window gives you a new terminal 
window and command-line prompt each time you click. Clicking the button for 
mail, the help manager, the style manager, or the trash can gives you a single 
instance of the service regardless of how many times you click the button. 

To modify what services appear in the workspace to better suit your needs, see 
"Customizing the Workspace Manager Layout" in chapter 8 or the HP VUE 
System Administmtion Manual. 

Switching Workspaces 

To switch to a different workspace, click a workspace button. 
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Renaming a Workspace 

By default, the six HP VUE workspaces are named One, Two, Three, Four, 
Five, and Six. While these are hardly original, they are easily changed. 

<=1 Rename Workspace 

ro;;;'--NN--~NNNNN'~'-l 
Workspace: One 

Iii OK III [ca~~~J L~~~~""J 

C Click to open the Rename Workspace dialog box. 

To rename a workspace: 

1. Switch to the workspace you want to rename. 
2. Click the rename workspace button. 
3. Double-click the Workspace box to select the text. 
4. Type the new name of the workspace. 
5. Press (Return) or click [OK]. 

Adding and Removing Workspaces 

See "Adding and Removing Workspaces" in chapter 8. 
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Hiding the Workspace Manager 

If you're really strapped for workspace "real estate," press mouse button 1 
with the pointer over the workspace background. When the workspace menu 
displays, choose Toggle Workspace Manager to change the workspace manager 
into an icon. 

Repeat the action, or double-click the icon, to change the icon back into the 
workspace manager. 

Logging Out from the Workspace Manager 

You can log out of your HP VUE session using either the workspace manager 
or the workspace menu. 

To log out using the workspace manager: 

1. Save all open data files. Unsaved files may be lost during logout, and some 
applications may need to be restarted when you log in again. 

2. Click the ribbing on the lower right of the workspace manager, the area 
around the progress light. You will notice it "push in" like a push button. 

3. Click [OK] to answer the Logout Confirmation dialog box. 

You can also log out by choosing Log out ... from the workspace menu (Press 
mouse button 1 on the workspace backdrop). 

Getting Help on the Workspace Manager 

Although the workspace manager doesn't have its own help button or a Help 
menu, help on the workspace manager is readily available. 
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1. Click the help manager [1]. 
2. When the help index appears, click Help on the Workspace Manager. 

Choosing Commands from the Workspace Menu 
Workspaces have a popup workspace menu. The workspace menu contains 
commands that are important but not required frequently enough to put them 
in the workspace manager. 

Workspace Menu 

Shuffle Up 

Shuffle Down 

Refresh 

Toggle Workspace Manager 

Restart Vuewm ••• 

Log out. .• 
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To choose from the workspace menu: 

1. Move the pointer over the workspace background (not over a window or 
icon). 

2. Press and hold down mouse button 1 to display the workspace menu. 
3. Drag the pointer to the item you want to choose. 
4. Release mouse button 1 to choose the command. 

Shuffle Up 

Shuffle Down 

Takes the bottommost window in a stack of 
overlapping windows and moves it to the top of 
the stack. 

Takes the topmost window in a stack of 
overlapping windows and moves it to the 
bottom of the stack. 

Refresh "Repaints" the screen should the video display 
become unreadable. 

Toggle Workspace Manager Turns the workspace manager into an icon. 
When selected a second time, it restores the 
workspace manager. 

Restart Vuewm ... Stops and then restarts Vuewm (the workspace 
window manager application) after you have 
customized workspace manager configuration 
files. 

Log out ... Begins the logout process, the same as pressing 
the ribbing around the progress light in the 
workspace manager. 

Menu items followed by " ... " open a dialog box. 
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Using the Window Menu 
Each application window has a window menu in the upper left corner of the 
window frame. The window menu provides easy access to services that control 
the behavior of the window. 

Size AIt+F8 

Minimize AIt+F9 

• M~imize AIt+F1O 

Lower AIt+F3 

· .Q.ccupy ... Alt+O 

Occupy!1I AIt+Shift+O 

Remove from WS AIt+Shift+F4 

· Close AIt+F4 

Typical services include: 

Restore Turns an icon back into a window. 

Move Interactively moves the window. 

Size Interactively changes the size of the window. 

Minimize Turns the window into an icon. 

Maximize Enlarges the window to its greatest allowable size. 

Lower Puts the window on the bottom of the stack of overlapping 
windows on the workspace. 

Occupy Opens a dialog box to select the workspaces in which the 
window should appear. 

Occupy all Displays the window in all workspaces. 

Remove from WS Removes the window from the current workspace. 

Close Closes the window, removing it from all workspaces. 
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Choosing Occupy... opens the Workspace Presence dialog box. The 
workspaces that a window currently occupies are highlighted. 

To add the window to another workspace, click the name of the workspace in 
the Workspaces list, then click [OK]. To put the window in all workspaces, 
select All Workspaces if it isn't already selected, then click [OK]. You can also 
choose Occupy All from the window menu. 

To delete a window from a workspace, click the name of a highlighted 
workspace in the Workspaces list, then click [OK]. 

Using Menu Mnemonics and Accelerators 
An underlined character in a menu item, usually the first character, is a 
mnemonic. A key sequence listed to the right of a menu item is an accelerator. 
Mnemonics and accelerators provide you with quick keyboard access to menu 
operations. 

Using Menu Mnemonics 

Once the menu is displayed, you can choose a menu item by pressing the key 
corresponding to the mnemonic character. (You don't have to use the mouse.) 

For example, you can click the window menu button of an application, then 
press GJ to choose Move from the menu. Pressing the arrow keys moves the 
window. Pressing and holding down (Ctrl) and then pressing an arrow key moves 
the window an even greater distance. 

Using Menu Accelerators 

With accelerators, you choose menu items without having to display the menu 
first. 

Thus, you could choose Move from the window menu of the active window by 
pressing @+@ ((Extend charl+@ on HP keyboards). Move the window with 
the arrow keys or mouse. 
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Sending and Receiving Mail 
The mail icon in the workspace manager changes to indicate that you have new 
mail. 

The mail icon has two other functions: 

• Drop a file icon onto it to mail the file. 

• Click the mail icon to start the mail program. Different operating systems 
use different mail programs. (The default mail program is elm for HP-UX 
systems .) 

To mail a file: 

1. Use mouse button 2 to drag a file icon from the file manager display area. 
Drop it onto the mail icon. 

2. Type the subject and destination into the displayed dialog box. 

3. Click [OK] to send the file. 

To read mail using elm (HP-UX systems): 

1. Click the mail icon to start elm. 
2. When elm appears, click [Read Msg] at the bottom of the window. 
3. Use the buttons at the bottom of the elm window to control the mailer's 

operation. 
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To send mail using elm (HP-UX systems): 

1. Click the mail icon to start elm. 
2. When elm appears, click [Mail Msg] at the bottom of the window. 
3. Follow the prompts that appear below the elm command line. 

For more information on elm, see the elm man page in the help index (click 
Man Page, then Standard HP-UX Commands, then search for elm). 

Printing 
To print from the workspace manager, use mouse button 2 to drag a file icon 
from a file manager display area and drop it onto the printer. 

rlw 

You can customize the print action to suit your specific needs. See "To modify 
the PRINT definition" in Chapter 8. 

Click the printer button on the workspace manager to open a window showing 
the status of printers connected to your workstation. To close the window, 
double-click the window menu button. 
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Running Applications 
The applications directory gives you easy access to the applications available on 
your workstation. 

To get to an application in the application directory: 

1. Click the applications directory button to display a file manager view of the 
application directory. 

2. Double-click the folder (if any) containing the application you want to run. 
On occasion, you may need to open several levels of folders before you get to 
the application icon. 

Once you have the application icon in view, you can start the application in 
several ways: 

• Double-click the application icon. 

II Drop a file icon on the application icon. 

• Drop the application icon on the workspace backdrop. 

You can also start some applications using just the file icons: 

• Drop the file icon on the workspace backdrop. If the file type has a default 
application, the application will start. 

• Select a file then choose the application from the file manager's Actions 
menu. 

Managing Your Workspaces 4-13 

41· 

1
1 

I 



For example, if your workstation were set up to take full advantage of the 
benefits of the application directory, you could start a vi editing session in any 
of the following ways: 

• Double-click the vi icon. 

• Drop a text file on the vi icon. 

• Drop the vi icon on the workspace backdrop. 

• Drop a vi text file icon onto the workspace backdrop. 

• Select a vi text file and then: 

4 0 Choose EDIT from the file manager's Actions menu. (You can do this if 
your system is configured so that the default EDIT action is vi). 

o Choose VI from the file manager's Actions menu. (You can do this if your 
system administrator has added VI to the Actions menu.) 

U sing the applications directory is covered in more detail in Chapter 6. To add 
to the applications in the application directory, see "Creating Your Own Action 
Definitions" in Chapter 8. 

Removing Files to the Trash Can 
To remove a file, use mouse button 2 to drag the file icon from a file manager 
display area and drop it onto the trash can. 

By default, when the trash can deletes a file, it removes it from the workspace 
but not from the workstation. You can restore "removed" files from the trash 
can until you log out. At logout, removed files are permanently deleted. 

To restore a removed file from the trash can: 

1. Click the trash can to display the Trash Can window. You can also choose 
Show Trash from the file manager File menu. 

2. Click the file you want to restore. 
3. Choose Restore from the Trash Can window's Edit menu. 
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Click the trash can. ~ 

To permanently delete a removed file: 

1. Click the trash can to display the Trash Can window. You can also choose 
Show Trash from the file manager File menu. 

2. Click the file you want to permanently delete. 
3. Choose Remove from the Trash Can window's Edit menu. 
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Using a Terminal Window 
HP VUE terminal windows provide you with access to the command-line 
prompt, and through it, operating system commands. Terminal windows 
also provide you with the ability to select and copy text from one window to 
another. 

Copying Text 

HP VUE terminal windows allow you to copy blocks of text. 

To copy text in a terminal window: 

1. Put the pointer over the first character in the text you want to copy. 
2. Press and hold down mouse button 1. 
3. Drag the pointer over the text you want to copy. The text is highlighted. 
4. Release mouse button 1. A copy of the highlighted text is now in an internal 

storage area. 
5. Position the pointer where you want to insert the clipboard text. 
6. Click mouse button 2. 

Additional copies of the highlighted text can be pasted by repeating steps 5 
and 6. 
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Resizing Window Contents 

With some operating systems, when you resize a terminal window by pressing 
mouse button 1 on the window frame and dragging the pointer, applications 
running in the window (such as the shell that supplies the command-line 
prompt) may not realize that you have resized the window. To inform the 
contents of a terminal window that the window is a different size, type the 
following at the command-line prompt of the resized window: 

eva! 'resize' (Return) 

(that's eva! space left quote resize left quote) 
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Getting Help 

The Help Manager informs you about HP VUE and its operation, and accesses 
the online man pages used for system administration and programming. 

5 



How to Get Help 
You can get help on any HP VUE application in the following ways: 

• Ask the workspace manager for the help index. 
• Choose an item from an application's Help menu. 
• Click a [Help] button in a dialog box. 

To learn ... Do this ... 

What an object is and how to use it. Choose On Item from the application's 
Help menu, then click the 1 pointer on 
the object. 

About an application. Choose On Application from the 
application's Help menu. 

About a dialog box. Click [Help] in that dialog box. 

i 5 
By doing a tutorial. Click [1] in the workspace manager. In 

the Help Index window, click [Viewer] 
and A Tutorial for lew Users. 

The date and version of an application. Choose On V ers ion from the 
application's Help menu. 

The mnemonic and accelerator keys for an Choose On Keys from the application's 
application. Help menu. 

How to operate an application step by Choose On Application from the 
step. applications' Help menu, then click the 

Using topic in the See Also section of 
the Help Viewer. 

About glossary terms and definitions. Choose Glossary View from the help 
viewer's Options menu. 

Operating system or programming Choose Man Page Search from the help 
reference information. viewer's Options menu. 
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Asking the Workspace Manager for the Help Index 

Asking the workspace manager for the help index gives you the most generic 
help. The index starts at the top level of help topics and is organized in a 
topic-subtopic hierarchy like the table of contents in a book. 

To get the help index from the workspace manager: 

1. Click the help button [1] on the workspace manager. 
2. When the index appears, click a topic. 
3. Click [Viewer] in the index to view information about the topic. 

File !:!.elp 

Introducing HP VUE Online Help Lines: 1 to 8 of 12 

A Tutorial for New Users 
Application Information 
Creating Your User Environment 
Glossary 
HP VUE Version & Copyright 
HP VUE Version 2.01 Release Notes 
Help on the Workspace Manager 
How to Write Online Help 

Show Search Option 

~ 11;= =;=::r~1 :=1 =:=:====:I :=1 =T=::=C ~I~ I_I 
!iiiU 1.,. ... ===ij ... E-~ 

Click the help button to open the Help Index. -.J 

If you're looking for help on a specific application, you'll find it under the 
Applications topic. 
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Choosing an Item from a 'Help' Menu 

The main window of each HP VUE application has a Help menu on its menu 
bar. 

The Help Menu Explained 

Most HP VUE Help menus look similar: 

Menu Item Description 

On Item Context-sensitive help on an application's graphical 
objects. 

On Application General help on a window, the counterpart of [Help] in a 
dialog box. 

On Help Instructions for operating the help manager. 

On Keys 

On Version 

Using a Help Menu 

Mnemonic and accelerator keys for the application. 

Date and version information for the application. 

A Help menu works just like any other HP VUE menu. To choose an item, 
either drag down through the menu and release mouse button 1 on the item, or 
click the menu title then click the item. 

To avoid choosing, press (Esc) or move the pointer off the menu before ending 
the drag or clicking. 

Clicking a [Help] Button in a Dialog Box 

When you click [Help] in a dialog box, you receive general help about that 
dialog box, the equivalent of On Application in a Help menu. 

Getting Help on Help 

You can get step-by-:-step help on operating the help manager from any HP 
VUE application by choosing On Help from the application's Help menu. 
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Using the Help Manager 
The help manager has three windows: 

Help Viewer Displays help text for your viewing. 

Help Index Displays the index of help topics from which to choose. 

Help Snapshot Makes a copy of a help text to keep in your workspace. 

While each window has a different function, you operate them similarly. 

Viewing Help Text 

To view help text without using the index: 

1. Choose On Item, On Application, or On Keys from the Help menu of an 
application, or click [Help] in a dialog box. 

2. Click topics in the See Also box to view related information. 

To view help text using the index: 

1. Click a topic in the help index. 
2. Click [Viewer] to open the help viewer. The text for that topic will be in 

the viewer display area. 

If the viewer is already in workspace, clicking a topic in the index changes the 
viewer text to that of the new topic. 

Displaying the Help Index 

To display the help index from the workspace manager, click the help button 
( [?]) on the workspace manager. 

To display the index from the help viewer, choose Index... from the Browse 
menu. 

Use the scroll bar to view a list of topics too big to fit in the index display 
area. 
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Viewing More Than One Help Text at a Time 

A snapshot keeps help text available without the other help windows cluttering 
your workspace. 

To take a snapshot of a help text, click [Snapshot] in the help viewer. 

Like text in the viewer, you can scroll a snapshot, search for a word, or print 
the text. 

A snapshot is a scrollable. ,t-----------------------'"'U 
searchable. printable copy 
of the original. 

A Tutorial for New Users Lines: 1 to 19 of 63 

Welcome to the HP VUE tutorial. ! 
Use the scroll bar on the right when there's tool 
much text to fit in the display area at one time! 

To move the text up one line: I 
1) Put the mouse pointer arrow on the downward I 

triangle at the bottom of the scroll bar. I 
1 

2) Click (press and release) mouse button 1 (thel 
mouse button under your index finger). I I 

Try it now so you can read the rest of this textl ! 

Good job! Do ita few more times and read on. ! I 
! ! 

When you click the downward triangle, notice thel i 
scroll bar's slider moves downward. The slider! l 
___ ~,_""W~'WN .• ~·.· __ ._"_·.,·~w._'W. __ "N'W.W~_w~w.''','', .•.. _ .... _ ..• w''''''~''w_'w~_~ __ .~_w_J 'zi 

r-~I I Help 

To remove a snapshot from the workspace, click [Close]. 
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Getting Status Information 

Each help window shows the topic name, the lines displayed, and the total 
number of lines. This information is always in view on the status line above the 
window's display area. 

The topic name is above and to the left of the display area. The lines displayed 
are above and to the right. The total lines are above and to the far right. 

To II 

UP 
t WelCOM to the If! VI. 

2) C Use the scroll bar ( 
.uch text to fit in 

Try To IIO\Ie the text up 

Good 1) Put the IIIOUSe po: .. _'_1 ................ & 

lines: 1 to 8 of 12 

This status line 
shows location 
information. 

In the index, each line is equal to a different subtopic, so the total number of 
lines tells you the number of subtopics. 

Scrolling through a display area changes the line numbers, telling you how far 
you've gone in a topic or list of subtopics. 

Notice also that the size of the scroll bar slider is inversely proportional to the 
number of lines; the larger the topic, the smaller the slider. 

Getting More Information 

Click a topic in the help viewer's See Also list to get more information on a 
topic or to view related topics. For example, each help topic on a window or 
dialog box has a See Also topic explaining the step-by-step operation. 
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Controlling Windows li~: 1 to 15 of 16 

You control windows by their window fr ... 
Basic window operations include: 

• Hoving 
• Resizing 
• Iconifying (timing II window into an icon). 
• Haking II window actil.'e (selecting which 

window gets input). 
• SlMfling windows (rearranging the "stacking 

order" of OYer lapping windows). 
• Using the window Mru. * Restoring II window fro. an icon. 

The index contains II list of step-by-step 
bi_ns_~ __ ti __ OO __ ~, ___ I~_·~~~~ ___ ~, __ ,, ________ ~ __ ~_~~ __ d ~ 

See Also Snapshot 

"See Also" topics give Restoring Windows fro. Icons ~ 
more information. --;;;;...;.~t\oy::i:ng::W:::indows:_"::=======_w.w.w ... v __ ,,,,,,,,"_:====~ I:~ 

r;:tNNV';;;;] rP;;i;;;;YiFl Options: None 

The See Also list is your most direct way of finding help information. 

Getting Access to HP LaserRom Documentation 

Using the HP VUE help manager, you can access HP LaserRom online 
documentation if you have that product available to your workstation. (The 
HP Visual User Environment System Administration Manual describes how to 
configure the the system to access the HP LaserRom.) 

To access HP LaserRom documentation: 

1. Click the help [?] on the workspace manager to display the help index. 
2. Click [Viewer] to display the help viewer. 
3. Choose HP LaserRom/UX from the Browse menu. 
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Going Back and Forth Between Texts 

On occasion, you may want to go back to a previously viewed topic, then 
return to the topic you're currently viewing. 

You can backtrack through the topics you've viewed using [Previous View] 
and [Next View] in the viewer or [Previous Index] and [Next Index] in the 
index. 

Next 

Getting Started File !!elp 

This section c 
to know before Introducing HP VUE Online Help Lines: 1 to 8 of 12 
applications. 

To select a se 

• Place the pc 
and click ..: 

• Use the kelt 
the selectic 

A Tutorial for New Users 
Application Infonoation 
Creating Your User Environment 
Glossary 
HP VUE Version & Copyright 
HP VUE Version 2.01 Release Notes 
Help on the Workspace Manager 
How to Write Online Help 

Options: 11--___ None ____ Q...I1 

Previous 

Click [Previous View] or [Previous Index] to go back to a previously viewed 
topic. Click [Next View] or [Next Index] to go forward to a more recently 
viewed topic. 
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Searching for a Word 

You can search for a word (or series of characters) in the display area of any 
help manager window. 

To display the 'Search for' box for the viewer: 

1. Click or drag the Options button (usually it reads [None]). 
2. Choose Text Search. . 

To display the Search for box for the index, click [Show Search Option]. In 
the snapshot, the Search for box is always present. 

Control Buttons 
Controlling Windows 
Ending II Session 
Icons 

Search For Search For: 

To search for a word: 

1. Click the Search for box in the appropriate help window. 
2. Type the word (or series of characters). If you mistype, edit with (Backspace) 

or (Delete char ). 

3. Press CRetUffi). 
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The next matching word appears highlighted in the text. The text in the 
display area scrolls if necessary to bring the word into view. Pressing ~ 
again continues the search, finding additional occurrences. 

You can also click [Find Next] to do the same thing. Clicking [Find 
Previous] searches the text from the current location to the beginning, the 
opposite of [Find Next] and (Return ). 

Searching for a Man Page 

A man page is an online reference to operating system commands and other 
technical information. ChoQse [Man Page Search] from the Help Viewer's 
Options menu, to search for online reference information. 

lines: 1 to U of ?;l 

The help Mnager consists of three separate 
windows, each hailing a specific f~tion: 

* The Help Yi __ contains help text. You request I 
the text b!:I pressing a [Help] button or b!:I I 
selecting an ita ff'Olll a Help --.!. :1,'. 

* The Help Index contains a list of available 
topics. Selecting a topic causes the text on , 

,,_"~~.~~~,~_~,_~,~.!:~_~~,~~~~~:,_""",, __ "_,. __ .~w,~_'"".".~ .. ~_,_"_., • .w'.w",~ __ ,.' :/J 
See Also Snapshot 

'----------='1%1 Use "Man Page Search" for 
@i----------------------NI online reference information. 

Han Page: 
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To search for a man page: 

1. Click or drag the help viewer's Options menu (usually it reads [None]). 
2. Choose [Man Page Search] . 
3. Click the Man Page box. 
4. Type the exact name of the man page. To edit, use [Backspace) or [Delete chad. 

5. Click [Show Man Page] to start the search. 

If you have a large number of man pages on your workstation, it may take the 
help manager a noticeable amount of time to search them. 

The help manager displays a message if it can't find the requested man page. 
Make sure you've typed the man page name exactly as you expect the help 
manager to find it. 

Man page text displays in the viewer's display area. Drag the corner of the 
window frame to enlarge the window if the text is too big. 

Like any text in a help manager display area, you can search for a word. See 
"Searching for a Word" above. 

Looking Up a Glossary Definition 

Use [Glossary View] from the Help Viewer's Options menu to select a term 
and view its definition. 

To display [Glossary View]: 

1. Click or drag Options (usually it reads [None]) 
2. Choose [Glossary View]. 
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Click a glossary term to 
view a definition. 

Lines: 1 to 1 of 'g 

See Also Snapshot 

~~~~:: ___ ~J~ [in] 

Glossal"\! TerM 

To view a definition, click the word in the Glossary Terms box you want 
defined. You can scroll the Glossary Terms box to view the complete list of 
available words. 

Printing Help Text 

You can print both viewer and snapshot text. The entire text of the topic 
prints, not just the text visible in the display area. 

To print viewer text: 

1. Click the File menu. 
2. Choose Print. 

To print snapshot text: 

Click [Print] in the snapshot window. 
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Managing Your Files 

The HP VUE file manager aids you in organizing and managing the 
information you store in your workstation. The workstation uses files as named 
"containers" to hold data. Directories, or "folders," are special files that hold 
regular files and other folders. 

6 



Getting a File Manager View 
You can always get a file manager view from the workspace manager by moving 
the pointer on the file manager button and clicking mouse button 1. 

~;: II ::e II~III ~ 1.111]~1 
J~!==!ij".": iii 

Click to open the File Manager. :J 

Once one file manager is in your current workspace, you can get other file 
managers in the following ways: 

• By pressing the file manager button again. 
• By selecting a directory icon and then choosing Open New View from the 

Actions menu. 
• By choosing New from the View menu. 
a By clicking [New View] after finding files with the Find Files dialog box. 

6 a By dropping a directory icon on the workspace background. 

What a File Manager View Tells You 
Besides the standard window frame, each file manager view has the following 
components: 

a Menu bar with pulldown menus. 
a Status line. 
a Display area. 

6-2 Managing Your Files 



!iii !iii a 
Graphics Memos xmcolor 

I] [; i 
Contents Covers Index 
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Chapterl Chapter2 Chapter3 

The Menu Bar with Pulldown Menus 

The file manager menu bar provides a central location for file and directory 
management actions. These actions are grouped into five menus. 

File Menu 

The File menu contains actions for creating, finding, and removing files, 
including: 

~opyAs ••. 

~roperties ..• 

Find ••• 

!rash FUe(s) 

Show Trash 

ndex 

i 
Chapter 1 
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New .•• 

Rename ... 

Copy As 

Proper­
ties 

Find ... 

Trash 
File(s) 
Show 
Trash 

Exit 

Directory Menu 

Creates a file of 0 length. (See chapter 8 to use this feature to 
create actions.) 

Renames an existing file. 

Copies a file to a new file name. 

Sets owner, group, and read, write and execute permissions. 

Searches for a file or directory. 

Removes selected files or directories. 

Opens the Trash Can window so you can see and restore 
removed files and directories. 

Closes this file manager view. 

The Directory menu contains actions applicable to creating, changing, and 
viewing directories, including: 

New ... 

Reread 

~hange To... <Ctrl>C 

Home <Ctrl>H 

U.e. <Ctrl>P 

Creates an empty directory. 

Rereads the current file and directory property information 
into the file manager display area. 

Change To ... Switches the view to a directory you specify. 

Home Switches the view to your home directory. 
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Up 

View Menu 

Switches the view to the parent directory, the directory 
containing the currently viewed directory. 

The View menu contains actions that affect your view of the files and 
directories contained in a file manager display area, including: 

New Opens a new file manager viewing the current directory. 

Select All Selects all files and directories in the current view. 

Unselect All Unselects all files and directories in the current view. 

Reorder ... Puts selected files and directories in an order you specify to 
execute them as a group. 

Pref erences ... Sets the order in which files and directories listed are 
viewed. 

Filter ... 

Save 
Settings 

Sorts files and directories, displaying only those that pass 
through the "filter" criteria. 

Saves the current preferences, filter, and window size. 
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Actions Menu 

The contents of the Actions menu are context-sensitive and change to reflect 
possible actions for the file or directory selected. If no file or directory is 
selected, the Actions menu is grayed out. 

Graphics Memos 

Data (usually text) file default actions available are: 

EDIT 

VIEW 

PRINT 

Displays the selected file in an editor window. 

Displays the selected file in a File Viewer dialog box. 

Prints the selected file. 

Executable file default actions available are: 

EXECUTE 

EDIT 

Starts the executable file, such as a script. 

Displays the executable file in an editor window. 

Directory default actions available are: 

Open In 
Place 

Open New 
View 

Displays the contents of the selected directory in the current 
file manager view. 

Displays the contents of the selected directory in a new file 
manager view. 
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Help Menu 

The Help menu provides you with help on the file manager. Among the types 
of help available are the following: 

On!:!elp ••• 

On!eys ••• 

On Version ••• 

<Ctrl>H 

<Ctrl>K 

<Ctrl>V 

On Item ... Context-sensitive help on any file manager graphical object. 

On Applica- Information about the current file manager view itself. 
tion ... 

On Help Information on operating the help manager. 

On Keys 

On 
Version 

Status Line 

The mnemonic and accelerator keys that operate the file 
manager. 

The version and date of the file manager. 

The status line is immediately below the menu bar. Aside from the information 
the line provides, you can double-click segments of the path to view that 
directory. You can also drag the current directory icon to an action icon to 
perform the action on the current directory, or to the workspace background to 
open another file manager view of the current directory. 

The syntax of the status line depends on the operating system your 
workstation is running. For example, on HP-UX workstations the status line 
looks like this: 

HostName: / PathSegment/ PathSegment/ PathSegment 
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whereas, on Domain/OS systems, it looks like this: 

/ / HostName/ PathSegment/ PathSegment/ PathSegment 

Host Name 

The host name (the first name in the status line) is the name of the 
workstation whose directory you are currently viewing. 

Current 
Directory 
Icon ----.;;;.. 

Going Up the Directory Path 

Following the host name, is the path of the directory being viewed. The path is 
made of segments similar to the branches of a genealogical tree. In a path, each 
segment (divided by a "/") is a directory. 

Double-clicking a path segment shows that directory's contents in the display 
area. Double-clicking the" /" after the host name shows the root directory's 
contents. 

The Meaning of "Files" and "Filtered" 

On the right side of the status line are the number of files and filtered files that 
the current view contains. 

The number of files represents the contents of the directory (including both 
files and subdirectories). The filtered number is the number of files and 
subdirectories contained in the directory, but that are not being viewed because 
they don't match the criteria specified in the Filter Files dialog box (View 
menu). The file counts include the current directory (.) and the parent 
directory ( .. ). 
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Display Area 

The display area shows the contents (except for "filtered" files) of the current 
directory, the last segment of the status line path. The View menu affects how 
and what files and directories appear in the display area. 

Changing the Appearance of the Display Area 

You can view the contents of the current directory as either icons (with names) 
or as a non-graphic list of file names, using the Set Preferences dialog box 
(choose Preferences. .. from the View menu). . 

The illustration below gives examples of what shows in the display area when 
an Order preference item is chosen . 

Note 

• By Name 

Graphics 

.. By Name and Icon 

Graphics 

.. By Name and Small Icon 

iii Graphi cs 

• By Properties 

fiiiiiiI drwxr-xr-x patti writer 24 Jun 14 09:03:07 1990 Graphics 

When you select By Name, you can use the "name" in the 
display area, the same way you use file and directory icons to 
perform actions, such as dragging and dropping. 

While viewing only the file name (By Name) does not tell you all the 
information known about a file, it may very well tell you all you need to know. 

Viewing a directory by property (By Properties), on the other hand, tells you 
the most information, which may be more than you want to know. 

Viewing a directory by small or large icon (By Name and Icon or By Name and 
Small Icon) gives you the file names and icons that distinguish graphically 
between directories and types of files (see the illustration below). 
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Directory --:;;':'':'':'':li.-. !iii 
Graphics Memos 

; ' ; ,. ,. - -Contents Covers 

Viewing a Large Directory 

II a ; I-Data File 

BIlL' xEcolor Chapter2 Chapter3 

. Executable Application 
HP VUE Action 

When the directory you are viewing is small, its contents fit in the display area. 
Large directories, however, have a scroll bar on the right side of the display 
area so you can scroll contents into view. 

Using the File Manager 
Use file manager menus to do file management tasks. You can do some tasks 
by dragging a file or directory icon and dropping it in a particular location. 
Other tasks require you to select a file or directory (or multiple files and 
directories) first. These tasks are grayed out in the menus until a selection is 
made. 

Selecting Files and Directories 

You can select any icon in the display area, any range of icons, or any 
combination of icons and ranges of icons. 
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Selecting a Single File or Directory 

To select a single file or directory, click its icon with mouse button 1. The icon 
highlights as a visual cue that you have successfully selected it. 

Selecting a Range of Files or Directories 

A range selection means choosing two or more files or directories that are right 
next to each other (contiguous) in the file manager display area. 

[iii [iii ali;] I 
Graphics Memos xmcolor Chapterl C lapter2 Chapter3 

[; [I I] ~ ;~ [; 
Chapter4 ChapterS Chapter6 Contents Covers Index 

To select a range of files or directories: 

1. Press and hold down mouse button 1 on the first or last icon in the range. 
2. Drag the pointer to the other end of the range. 
3. Release mouse button 1. 

Selected files and directories highlight as a visual cue of their selection. 

Selecting Files and Directories at Random 

A random selection is the selection of two or more files or directories that are 
not next to each other (non-contiguous) in a file manager display area. 
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!iii !iii a iJ 
Graphics Memos xmcolor 

r; I 
Contents Covers 

To select files or directories at random: 

1. Select the first icon or range of icons. 
2. Hold down (CTRL) and make your next selection. 
3. Release (CTRL ). 

6 To unselect randomly from a group of selected files or directories: 

1. Move the pointer over the file or directory to unselect. 
2. Hold down (CTRL) and click mouse button 1. 
3. Release (CTRL ). 

Selecting and Unselecting With the View Menu 

You can select all files and directories in the display area by choosing Select 
All in the View menu. 

To select almost all files and directories, select all, then randomly unselect the 
ones you don't want. 

You can unselect all files and directories in the display area by choosing 
Unselect All in the View menu or by moving the pointer over an empty area 
in the display area and clicking mouse button 1. 
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Moving a File or Directory 

You can perform actions on files and directories by dragging and dropping their 
icons. Where you drop an icon affects what happens. 

Dropping an icon on ... Does this ... 

Another file manager view Moves (transfers) the file or directory to that directory 
being viewed. 

A directory icon Moves (transfers) the file or directory into that directory. 

The printer Prints the file. 

The trash can Removes the file from the directory. 

The workspace Performs the default action on that file or directory. For 
example, a text file might open for editing, a directory 
would open for viewing. 

An action icon Performs the action on the file or directory. 

To move a file or directory: 

1. Move the pointer on the file or directory icon. 
2. Press and hold down mouse button 2. 
3. Drag the icon to the target location. 
4. Release mouse button 2 to "drop" the icon on that location. 

Copying a File 

You can copy a file by dragging it to a target location: either another file 
manager or a directory icon. You can also copy a file by selecting Copy As ... 
from the File menu and typing a destination, including a path. 
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To copy a file with a mouse: 

1. Set one file manager to display the file you want to copy. This is the source 
view. 

2. Set a second file manager to display the directory to which you want to copy 
the file. This is the target view. 

3. Move the pointer over the file you want to copy. 
4. Press (CTRL ), and while holding it down, hold down mouse button 2. 
5. Drag the file from the source view to an open area of the target view. 
6. Release mouse button 2. 
7. Release (CTRL ). 

If you release (CTRL) before mouse button 2, a move is performed. 

You can also copy a file by dragging its icon onto a directory icon. 

To copy a file using Copy As: 

1. Click the file you want to copy. 
2. Choose Copy As ... from the file manager File menu. 
3. Click the New File Name box to display the text insertion cursor. 
4. Remove the old name. 
5. Type the new name. 

6 6. Click [OK] or press (RetUT). 

Creating Files and Directories 

You can use the file manager to create a file or a directory, giving it a unique 
name. You can precede the name with a complete directory path to place it in 
a directory other than the current directory. 
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New Data File 

New Data File Name: I I ~ ;TA 

Rename ... 

£opyAs ... 

!ropertles .•. 

Find ... 

!rash File(s) 

Show Trash 

To create a file: 

r---ciK--] I Cancel I "---, .. ,------"--'''-" j Show File Type r--;;;;;-, 

1. Open a file manager view of the directory that will contain the new file. 
2. Choose New... from the file manager File menu to display the New File 

dialog box. 
3. Click the New Data File Name box to display the text insertion cursor. 
4. Type the name. 
5. Click [OK] or press (Return J. 
This creates a file of 0 length, an "empty" file to which you can add text, for 
example. 

To create a directory: 

1. Open a file manager view of the directory that will contain the directory you 
are creating. 

2. Choose New... from the file manager Directory menu to display the New 
Directory dialog box. 

3. Click the New Directory Name box to display the text insertion cursor. 
4. Type the name of the new directory. 
5. Click [OK] or press (Return J. 
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Finding a File or Directory 

You can use the file manager to search for files and directories without knowing 
their locations or even their exact names. By default a search starts at the 
current directory and looks for all files and subdirectories in the current 
directory. However, you can change the scope of a search. 

To find files or directories: 

1. Open a file manager. 
2. Choose Find... from the File menu to open the Find Files dialog box. 
3. Specify the scope of your search (see below). 
4. Click [Start] or press (R'etU'm) to begin the search. 

Find Flies 

File Name: * 

Search Directories: 

Size (In K bytes) Dates (mm/dd/yy) 

Smaller Than: L ___ ~ __ .-J Modified Before: L_~_~~j 

Larger Than: Modified After: 

Flies Found: 

When the search starts, [Start] grays out ~s a visual cue that the search is 
underway. Files or directories found by the search display in the Files Found 
box. 

Click [Stop] to cancel the search. 
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Specifying the Scope of a Search 

To search for specific files: 

1. Click the File Name box to display the text insertion cursor. 
2. Type the file, directory, or the sequence of characters for which to search. 

See the table below for examples. 
3. Click [Start] or press ("Rei'ljffl) to start the search. 

Tips for Searching By File Name 

*.c finds all files in the specified directory tree that end in ".c". 

8YS.* finds all files in the specified directory tree that start with "sys.". 

*foo* finds all files in the specified directory tree that have "foo" in their 
names. 

too??bar finds all files in the specified directory tree that start with "foo," end 
with "bar," and have any two characters in between. 

[mM]ake finds all "make" or "Make" files in the specified directory. 

To search a specific directory: 

1. Double-click the Search Directories box. 
2. Type the directory path. By default, the current directory (.) and its 

subdirectories are searched. 
3. Click [Start] or press ("Rei'ljffl) to start the search. 

You can specify an absolute path, one beginning with the root directory (I), or 
a relative path, one beginning with the current directory. To search more than 
one directory at a time, separate the search paths by a space or tab character. 
The more complete the path, the narrower the search. 

To search by size: 

1. To search for files or directories smaller than a certain size, click the 
Smaller Than box to display the text insertion cursor. 

2. Type the maximum size of the files or directories you want to find. 
3. Click [Start] or press ("Rei'ljffl). 
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To search for files larger than a certain size, follow the above steps using the 
Larger Than box instead of Smaller Than. 

To search by modification date: 

1. To search for files or directories modified or created before a certain date, 
click the Modified Before box to display the text insertion cursor. 

2. Type the date files must be older than. Use mml dd/yy. 
3. Click [Start] or press (RetUT). 

To search for files or directories modified or created after a certain date, follow 
the above steps using the Modified After box instead of Modified Before. 

Renaming a File or Directory 

To change the name of a file or directory: 

1. Open a file manager. 
2. Click the file or directory you want to rename. 
3. Choose Rename ... from the File menu to display the Rename File dialog 

box. 
4. Click the New File Name box to display the text insertion cursor. 

6 5. Type the new name of the file or directory. The name must be one word, no 
spaces or tabs, and unique to the directory in which it is contained. 

6. Click [OK] or press (Return) to complete the renaming. 

Click [Cancel] to avoid renaming. 

Typing the name and clicking [Show File Type] shows you what icon will be 
associated with the new name. 

Removing and Restoring a File or Directory 

You can remove any of your files or directories by dropping them into the trash 
can. Once in the trash can, you can restore them, or you can remove them 
permanently. 

Caution 

I 
You can restore files or directories for a limited time only. Files 
or directories that you drop in the trash can are permanently 
removed when you log out. 
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To drag a file or directory to the trash can: 

1. Open a file manager. 
2. Move the pointer over the file or directory icon (or a selected range of icons). 
3. Press and hold down mouse button 2. 
4. Drag the file or directory icon over the trash can. If the icon is a non-empty 

directory, the system displays a dialog box. To proceed with the removal, 
click [OK]. 

5. Drop the icon into the trash can (release mouse button 2). 

To cancel a drag operation, press the (ESC) key before releasing mouse button 2. 

To remove a file or directory using Trash File(s}: 

1. Open a file manager. 
2. Click the file or directory you want to remove. 
3. Choose Trash File(s) from the File menu. 

Note that you can remove a range of files or directories (be careful) or a 
non-contiguous selection. 

To avoid removing the file or directory, press (ESC) or move the pointer off the 
menu and click mouse button 1. 

To restore a file or directory: 

1. Click the trash can or choose Show Trash from the file manager's File menu 
to open the Trash Can window. 

2. Click the file or directory you want to restore. 
3. Choose Restore from the Edit menu. 

Changing File or Directory Properties 

Files and directories have a number of attributes called properties. Properties 
give you the following information: 

Owner name The login name of the person to whom the file or directory 
currently belongs. Usually this is.the person who created it. 

Group name The name of a special group of users, all of whom have access 
to the file or directory. 
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Read 
Permission 

Write 
Permission 

Execute 
Permission 

Anyone with this permission can view and copy a file or 
directory. 

Anyone with this permission can modify a file or directory and 
can remove a file or directory if the parent directory gives write 
permission also. 

Anyone with this permission can search a directory or execute 
a file (or a file in a directory, if the directory is executable 
also ). 

File Properties 

File Name: hpcvxper:/users/pattl/Projects 

Owner Name: I!'~::,~~_J I!!CTORVI 
Group Name: l,lIri tar I 
Permissions: 

Read Write Execute 

Owner: 0 0 0 
Group: 0 0 0 
Other: 0 0 0 

Size (In bytes): 1024 Modified: 08/15/90 

i OK I I Cancel "I r~"HeI;-'-1 

The File Properties dialog box, which you use to change properties, also lists 
the size of the file or directory and the date on which it was last modified. 

To change a file or directory property: 

1. Open a file manager. 
2. Click the file or directory whose properties you want to change. 
3. Choose Properties... from the File menu to display the File Properties 

dialog box. 
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4. Click the property you want to change. When clicked, unselected 
permissions become selected; and when clicked, selected permissions become 
unselected. For Owner Name or Group Name, use [Backspace) or [Delete chad to 
delete the old owner or group before typing the new owner or group. 

5. Click [OK] to complete the change and close the dialog box. 

To avoid making any modifications, click [Cancel]. 

Updating a File Manager View of a Directory 

While a file manager's view of the contents of a directory updates 
automatically to include most changes to files and directories, changes 
you make to properties (owner name, group name, permissions) are not 
automatically reflected. However, should you want to, you can update the file 
manager view yourself. 

To update the file manager view: 

Double-click the current directory icon (located in the status line under the 
menu bar, or choose Reread from the Directory menu. 

Changing Directories 

U sing the file manager, you can navigate up or down your directory tree, your 
workstation's hierarchical directory and file structure. 

To go down the directory tree: 

1. Open a file manager. 
2. Double-click the directory icon or name to which you want to go. 

The directory name is added to the path on the status line, and the display 
area shows the directory's contents. 

To go up the directory tree: 

Double-click the path segment (following host name on the file manager status 
line) to which you want to go. The segment highlights and the file manager 
display area changes to reflect the new view. 
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Double-click the status line path 
segment to change directories. 

In Domain/OS systems, double-clicking / / switches to the node entry 
directory. 

To go to your root directory: 

.. Double-click the "/" after the host name in the status line (all operating 
systems except Domain/OS) . 

• Domain/OS systems: double-click the node name in the status line. To go to 
the node entry directory, double-click / /. 

To go up one level in the directory tree: 

Choose Up from the file manager Directory menu. 

To go up the directory tree (another way): 

1. Choose Filter from the file manager View menu to display the Filter Files 
dialog box. 

2. Click Show Hidden Files if it isn't already selected. 
3. Click Apply. 
4. Click Close to remove the Filter Files dialog box. 
5. Double-click the .. (parent) directory icon. 

To go to your home directory: 

Choose Home from the file manager Directory menu. 

To change to a frequently used directory: 

1. Choose Change To ... from the file manager Directory menu to display 
the Change Directory dialog box. 
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2. Type the name of a directory to which you frequently go. Use the complete 
path. 

3. Click [OK] or press (Return) to change to that directory and close the dialog 
box. 

The Change Directory dialog box preserves a list of directories you've changed 
to using it. 

To change to a directory in the directory list: 

1. Choose Change To ... from the file manager Directory menu to display 
the Change Directory dialog box. 

2. Double-click a directory in the list box to have the file manager view change 
to that directory. 

Host hpcvxpw3 

hpcvxpw3:/usr/llb/X11/vue 
hpcvxpw3:/users/anna/. vue 
hpcvxpw3:/users/Janlce/. vue 
hpcvxpw3:/usel s/whip 

nul Double-click a path 
! to change to that I directory. 

I 
I 

"~-=~.~-.,-.. ,-""~~~.~,,--~.~.,,".~--~j 

New Directory: 

A 
·~ _____ '''''NV' .... HNh"''''''''''''''hWNNHH~_'''''''.'N.WNNW_ 

Changing Your View of a Directory 

You can change your view of a directory by: 

II Setting your viewing preferences. 
II Filtering files and directories so only the ones you specify show. 
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To set viewing preferences: 

1. Choose Preferences... from the file manager View menu to display the 
Set Preferences dialog box. 

2. Click the viewing preferences you want to set. 
3. Click [Apply] to have the changes take effect or click [Reset] to return 

viewing preferences to their last applied settings. 
4. Click [Close]. 

Set Preferences 

'-Show ,View 

.. By Single Directory + By Name 

<) By Directory Graph <) By Name and Icon 

<) By Name and Small Icon 

<) By Properties 

,Order ,Direction 

.. By File Type • Ascending 

<) Alphabetically <) Descending 

<) By Date 

<)BySlze 

'-
Apply =, I Reset r'" Close I r";;;.;"m'"l 
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Choose ... To show ... 

By Single Directory The contents of the current directory. 

By Directory Graph The "tree" structure of the file system, starting at root 
(/). 

By File Type Directories first, action and executable files next, then 
data files. 

Alphabetically The contents of the current directory alphabetically. 

By Date The contents according to the date created or last 
modified. 

By Size The contents of the current directory in order of their 
sizes. 

Choose ... To show ... 

By lame The contents of the current directory by name only. 

By lame and Icon The contents of the current directory by name and icon. 

By lame and Small The contents of the current directory by name and small icon. 6 
Icon 

By Properties The contents of the current directory by icon, name, owner, 
group, and read, write, and execute permissions. 

Ascending The contents of the current directory in alphabetical order, or 
starting with the most recent date, or starting with the smallest 
file first (depending on the Order button selected). 

Descending The contents of the current directory in inverse alphabetical 
order, or starting with the oldest date, or starting with the 
largest file first (depending on the Order button selected). 
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To filter files and directories: 

1. Choose Filter ... from the file manager View menu to display the Filter 
Files dialog box. 

2. Enter the criteria that files and directories must match (or not match) to be 
displayed in the file manager view. 

3. Click [Apply] to put these "filters" in effect or click [Reset] to return to 
the last applied filters. 

4. Click [Close] to remove the Filter Files dialog box from the workspace. 

File Name: * 

o Match the File Name 

Size (In K bytes) 

Smaller Than: 

Filter Files 

o Show Hidden Flies 

Dates (mm/dd/yy) 

Modified Before: t_~ __ 
Modified After: 

Use the following table to choose the criteria through which directory contents 
should be filtered. 
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To view ... Do this ... then click [Apply] 

Contents matching a Type the character sequence in the File lame box with 
character sequence. Match the File lame selected. 

Contents not matching a Type the character sequence in the File lame box with 
character sequence. Match the File lame not selected. 

The entire directory. Type an asterisk (*) in the File lame box with Match 
the File lame and ShOll Bidden Files both selected. 

Hidden 'dot' files. Select ShOll Bidden Files. 

Contents smaller than a Type the size in the Smaller Than box. The size is in 
certain size. kilobytes. 

Contents larger than a Type the size in the Larger Than box. The size is in 
certain size. kilobytes. 

Files modified or created Type the date in the Modified Before box. 
before a certain date. 

Files modified or created Type the date in the Modified After box. 
after a certain date. 

Saving File Manager Settings 

Once you have set the window size, viewing preferences, and file filters for the 
file manager, you can save those settings. The saved settings will be in effect 
each time you start a new file manager view. 

To save your file manager settings: 

1. Choose Save Settings ... from the file manager View menu. 

2. Confirm that you want the settings saved by clicking [OK] in the Save 
Default Settings confirmation box. 

You can save different settings for regular file manager views (opened using the 
file manager button in the workspace manager) and views of the applications 
directory (opened using the applications directory button in the workspace 
manager). 
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Three I 0 Sbc I ~ ~ rn 
.!'G!!": 

I!~~I ... 1-

---
File manager button ~ ~ Application. dlrectooy button 

You can save separate settings for file manager views 
opened using these two buttons. 

Changing the Order of Files 

You can temporarily reorder files, putting them in the order in which you want 
them to "execute." For example, you may want to print or compile files in an 
order other than alphabetically. 

The Reorder Selection dialog box provides a temporary way to "cut and paste" 
files in an order you choose. When you drop the reordered group of selected 
files on a command icon, such as the printer or a compile executable file icon, 
they "execute" in the order in which you "cut and pasted" them. 

Reordering is transparent and does not change how files are shown in a file 
manager display area. 
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Preferences ..• 
Proj ects 

To reorder selected files: 

Reorder Selection 

Selection List 

hpcvxper:/users/patti/Projects 
hpcvxper:/users/patti/Abe 

Cut Area: 

OK I i Cancel I 1-__ --' 

1. Select the files (must be two or more) on which you want to perform an 
action. 

2. Choose Reorder ... from the View menu to open the Reorder Selection 
dialog box. The files selected in step 1 appear in the Selection List box. 

3. Select the file ( s) you want to put in a different place in the list. You can 
select files in the list the same way you select icons in a file manager display 
area. 

4. Click [Cut] to move the file ( s) to the Cut Area. 
5. Click the file in the Selection List before or after which the cut file ( s) 

should be placed. 
6. Click [Paste Before] to put the cut file(s) before the selected file or click 

[Paste After] to put the cut file ( s) after the selected file. 
7. Click [OK]. 
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To "execute" the files in the order in which your arranged them: 

1. Move the pointer on one of the selected files in the file manager display area. 
2. Press and hold down mouse button 2. 
3. Drag the icon (representing all the files) over a command icon, such as an 

executable file or the printer. 
4. Drop the icon (release mouse button 2). 

The reordering is temporary; it lasts only while the files remain selected. 

Using Actions 
Actions lets you execute commands without having to type the command 
on a command line. An action may perform a single command or a series 
of commands. It can execute a shell script, an executable program, or an 
application. 

You do not need to know how an action is implemented to use it (implementing 
actions is covered in chapter 8 of this manual and in the HP Visual User 
Environment System Administration Manual.) You just have to know the 
various ways of starting an action: 

II Double-clicking a non-directory file icon or dropping it onto the workspace 
background does the default action for that file type. For example, 
double-clicking a directory icon opens a file manager view of that directory, 
and double-clicking a data file icon opens that file in an editor window . 

• Selecting the file and then choosing an action from the file manager Actions 
menu does the selected action using that file . 

• Actions can be associated with action icons. You can then invoke the action 
by double-clicking the action icon or by dropping a file icon onto the action 
icon. 
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Default Actions 

The default action for a file depends on the type of the file. 

The default action for a directory displays the contents of the directory. The 
default action for most data files is to load the file into an appropriate editor. 
For example, the default action for a text file displays the file in a text editor. 
Similarly, files containing graphics data are loaded into a graphics editor. 

It is possible to create file types that have more specific default actions. For 
example, the default action for an encrypted text file could be to simply 
decrypt the file. 

Using the Actions Menu 

The Actions menu appears grayed out if no file or directory is selected, or if 
more than one file or directory is selected. To use the Actions menu, select 
only one file or directory. 

The items that appear on the Actions menu depend on the file type of the 
selected file or directory. 

Directory Actions 

HP VUE comes with the following directory actions: 

Open in 
Place 

Open New 
View 

Displays the contents of the selected directory in the current 
file manager view. 

Displays the contents of the selected directory in a new file 
manager view. 

Data File Actions 

HP VUE comes with the following data file actions: 

EDIT 

VIEW 

PRINT 

Starts an editing session on the selected file. (You must have 
write permission for the file.) 

Opens a File Viewer window showing the selected file. (You 
must have read permission for the file.) 

Prints the contents of the selected file if your workstation is 
configured to print. 
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Executable File Actions 

HP VUE comes with the following executable file actions: 

EXECUTE 

EDIT 

Starts the executable file. (You must have read and execute 
permission for the file.) 

Starts an editing session on the selected file. (You must have 
read and write permissions for the file.) 

See Chapter 8 for information on creating your own file types and actions and 
adding actions to the applications directory. 

Using Action Icons 

Locating Action Icons 

You can see the the action icons available on your workstation by clicking the 
applications directory button to open a file manager view of the applications 
directory. The applications directory is the. vue/apps subdirectory of your 
home directory. 

-=;=: ===:11 ::. III.' ~ ~ rn 
J~-===ij __ ._1 - -

Click to open a File Manager view of the Applications directory 

The display area shows you several folders (subdirectories) containing actions: 

• system_apps contains actions supplied with HP VUE or actions that have 
been separately purchased and installed. 

• local_apps contains actions provided by your system administrator for 
everyone using your workstation. This folder is present only if your system 
administrator created it. 

• personal_apps contains your own personal actions. This folder is visible 
only if you have created personal actions. 
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• Your workstation may be configured to show additional folders of actions­
for example, folders for games or other applications. 

fill 
locaLapps persona Lapps system-apps 

These folders may contain action icons and/or other folders. For example, 
system-apps contains a variety of folders, including a print folder for printing 6 
actions and and an edit folder for editing actions. 
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• • • • X1 Lapps edit mail print 

• terminal 

Copying Actions 

Like all other file manager icons, you can copy action icons to other directories 
(hold down the (CTRL) key while dragging it to its target location). For 
example, you may find it convenient to copy all of your most commonly used 

6 actions into a single folder. 

Action icons take up very little space on your workstation, so do not be afraid 
to make as many copies of them as you wish. 

Starting Actions Using Action Icons 

The simplest way to start an action is to double-click tp-e action icon. For 
example, if you have an action for a game, double-clicking the action icon 
starts the game. It may take a few seconds for the action to start; in the 
meantime, you should see the progress light in the corner of your workspace 
manager Hash. 

Some actions require "arguments"-that is, you must provide certain 
information in order to do the action. For example, a printing action requires 
a file argument; you must tell the system what file you want to print. Other 
actions require non-file arguments. 
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When you double-click an action that requires an argument, the action displays 
a dialog box that requests the information. For example, the BITMAP action 
ask you for the name of the file you want to edit and the width and height of 
the bitmap. After filling out the dialog box, click [OK] to start the action. 

Action: BITMAP 

The following parameters are missing, and need to be supplied: 

File To Edit: I 
~"-'-'''~~-''.''~---''-'~--''''-''-'''-'~'~-~-'-''~~''~''--"'~-'" 

Width: t_""W'~NN_Nh_~'", .. _,_,_,.~~ __ v_,._w., ____ ..• '~.m",_~~_~, ___ ~_ .. ____ ,.wN __ .... _l 

Height: L_""' __ , __ '._H _____ ' _______ ' __ N __ "'~ __ ~N __ H ____ "'"_, 

; Cancel I ! ;~ ____ ~ 1~ ____ ~ Help 

Many actions require a "file" argument. If you enter a simple file name such 
as myf ile, the action will look for this file (or create it) in the same folder 
where the action icon is located. If you want to supply the name of a file 
in a different folder, you must enter the full name of the file. For example, 
/users/anna/chores/mylist. 

An alternative method for supplying a file argument to an action is to drop a 
file icon onto the action icon. This starts the action using the supplied file as 
an argument. 
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If an action requires both file and non-file arguments, the action displays the 
dialog box when you drop the file argument on it. 

It is even possible to select several files and drag the entire group onto the 
action icon. 
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Tailoring Your Environment with Style 

This chapter shows you how to customize your workstation with the style 
manager. 

7 

7 



7 

Opening and Closing the Style Manager 
You can open the style manager from the workspace manager by moving the 
pointer on the style manager button in the workspace manager and clicking 
mouse button 1. 

Fila !!alp _,-1 
Baclcdrop ~ 

~ I~I =one ~I ~I =TWO ~II ~I =Three~IIIII~ ..•.. 
::...J J Four II Five II Sbc .. ~ _: I""~.=!!".--t Click to open the Style Manager. 

The style manager has a menu bar, containing two menus: File and Help. It 
also has nine push buttons, one for each part of your environment that you can 
change with the style manager. These push buttons open dialog boxes. To 
open a dialog box, move the pointer over one of the nine buttons, and click 
mouse button 1. 
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Choose ... To change ... 

Color Workspace colors and color palettes. 

Font Font sizes. 

Backdrop Workspace background patterns. 

Keyboard Key click volume or character repeat capability. 

Mouse Mouse button click settings, pointer acceleration, pointer movement 
threshold, or double-click speed. 

Audio Audio volume, tone, or duration. 

Screen Screen time-out interval. 

Hosts Which workstations on your network can display information on 
your workstation's screen. 

Startup How your next HP VUE session starts. 

To close the style manager, choose Exit from the File menu. 

Getting Help on the Style Manager 
The Help menu provides you with help on the style manager. Among the types 
of help available are the following: 

On Item ... 

On Application 

On Help 

On Keys 

On Version ... 

On Man Page ... 

Context-sensitive help on any style manager graphical 
object. 

Information about the style manager window. 

Information on operating the help manager. 

The mnemonic and accelerator keys that operate the 
style manager. 

The version and date of the style manager. 

The style manager (vuestyle) man page. 
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To get help from the style manager window: 

1. Click Help in the style manager menu. 
2. Click your choice to open a Help window. 

To get help from the style manager's dialog boxes: 

Each dialog box has a [Help] button in the lower right-hand corner. Click 
[Help] to get information about the dialog box in which you're working. 

Changing Workspace Colors 
Your display type determines the color palettes available. Each type has a 
specific number of color buttons that make up a color palette. 

Type of Display Number of Color Buttons 

high color 8 

medium color 4 

low color 2 

monochrome (black & white) 2 

lllustrations in this guide are for a high-color display, with eight color buttons 
in the Color dialog box. 
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Color 

CoralReef' ~.' ~ Dakota 
Dalla 

palette -- l1li$" · I 
E~ioox ! 
Esquire_~"~,~ __ ,D 

r1

-

File 

r~~Add:::-"W~1 

f)i;l;t;:::=] 

~~ !!]l!!J!!J 
Click to open the Color dialog box. 

To change workspace colors: 

!!elp 

.ur.r.~1 
Hosts ~ 

1. Click Color in the style manager to open the Color dialog box. 
2. Click a palette to apply it to your workspace. 
3. Click [OK] to close the dialog box. 

Click [Cancel] to close the dialog box and return to the workspace colors you 
had before opening the dialog box. 

If you have a color display, your workstation has more palettes than appear in 
the Palettes viewing area. You can use the scroll bar to see what's available. 
You can also scroll through the palette list by moving the pointer over a 
palette, holding down mouse button 1, and dragging through the list. 
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Modifying a Color Palette 

If you have a color display, you can modify a palette's colors with the Modify 
Color dialog box. 

Color 

Palettes----------""I 

Ashley Modi Color 
AtrIum 

BarrierReef 
Color Sample---------------, 

Broica 

Broica-----------, Color Editor---------------, 

Double-click a color button 
or click a button. then 
click [Modify ... ] to open the 
Modify Color dialog box. 

238 

238 

238 
8 

o 
saturatlon-

II
-
I
_ ~ 

Value -- ct [~m"m"N_"N~m~"N."m ____ mN""~'"'_ •. ~~_"NN~J:L:JN~J 

l······ ,·,·'''01('''····''··'1 

Hue 

o 

! 
1 

J 

The eight color buttons below the Palette list are the current palette's colors. 
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Use ... To ... 

Old See the original color. 

New See the color as it's adjusted. 

[Grab Color] Choose a color from the workspace. 

R Change the amount of red (in decimal values). 

G Change the amount of green (in decimal values). 

B Change the amount of blue (in decimal values). 

Hue Change red, green, and blue proportions (in decimal values). 

Saturation Change the color's intensity (in decimal values). 

Value Change the color's brightness (in decimal values). 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes and close the dialog box. 

[Help] Give you information about the dialog box. 

To modify a color: 

1. In the Color dialog box, click the palette name. 
2. Double-click the color button (or, click the color button, then click 

[Modify . .. ]) to open the Modify Color dialog box. 
3. Adjust the color by dragging the sliders. 
4. Click [OK] in the Modify Color dialog box. 
5. Repeat steps 2-4 to modify other colors in the palette. 
6. Click [OK] to save the palette and close the Color dialog box. 

For more accuracy in choosing slider values, click the slider, then use the right 
and left arrow keys to move the slider incrementally. 

Moving the R(ed), G(reen), or B(lue) sliders sometimes moves the Hue, 
Saturation, or Value sliders automatically. Also, as you move the sliders, the 
New color updates your screen. 
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To grab a color from the workspace: 

1. In the Color dialog box, click the palette name you want to modify. 
2. Double-click the color button you want to modify (or, click the color button, 

then click [Modify ... ]). 
3. Click [Grab Color] to change the pointer into a cross hair. 
4. Click a color in your workspace. 
5. Click [OK] in the Modify Color dialog box. 
6. Repeat steps 2-5 to modify other colors in the palette. 
7. Click [OK] to save the palette and close the Color dialog box. 

To avoid grabbing a color and return your pointer to its normal shape, press 
[Esc J. 
Some workspace colors are generated by tiles (patterns) of two other colors. If 
you try to grab a tiled area, you will get only one of those colors. 

Adding a Palette 

If you have a color display, you can add a color palette to the list. 

Color 

Palettes---------_ 

~L Click [Add ... ] to ope. 
l • the Add Palette dialog box. 

fo;.;rt;::] 
Broica 

Broica---------_ 
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To add a palette: 

1. In the Color dialog box, click any palette in the list. 
2. Click [Add ... ] to open the Add Palette dialog box. 
3. Click the New palette name box to display the text insertion cursor. 
4. Type the new palette name. 
5. Click [OK] in the Add Palette dialog box. 
6. Modify the palette colors, if desired. 
7. Click [OK] in the Color dialog box. 

Deleting a Palette 

You can delete unused palettes from the palette list. However, you must keep 
at least one palette in the list or your display would be blank! 

Color 

Palettes---------.. 

Ashley 
AtrIum 
BarrierReef 
Broica 

To delete a palette: 

r~D;';;:':~"T- Click [Delete ... ] to open the 
Delete Palette dialog box. 

.. Delete palette "Broica"? 

1. In the Color dialog box, click the palette you want to delete. 
2. Click [Delete ... ] to open the Delete Palette dialog box. 
3. Click [OK] in the Delete Palette dialog box to confirm your choice. 
4. Click [OK] in the Color dialog box. 
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Restoring a Palette 

If you delete a palette, HP VUE renames it by preceding the original name 
with a -, and places it in your $HOME/ . vue/palettes directory, the same 
directory in which the palettes you add are placed. 

To restore a palette: 

1. Change to your $HOME/ . vue/palettes directory. 
2. Rename the palette from - PaletteName.vp to PaletteName.vp. 
3. If the style manager is open, close it. 
4. Reopen the style manager to see the restored palette placed at the bottom 

of the Palettes list. 

Changing Font Sizes 

You can choose small, medium, or large fonts. Not all workspace fonts can be 
changed, because some applications don't talk to the style manager. 

When you choose a font size, you must restart your HP VUE session (log out 
and log back in) to use the new font size. 

To avoid having to log out and log back in, you can use the 
Vuestyle*vriteXrdblmmediate resource, but the the new font size is 
used only in applications started after choosing the font size. See "Adding 
Resources to the Resource Database" in Chapter 8. 
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=1 Fonts 

III Font Size [H;ii;; .... g.! r-Font Preview 

~--------------~ 
By Application: ------.., 

r!hb~OOJ 

Application Halle 

I All applications I 
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Areas where you can 
type will look like 
this. Select the 
box be low and type I 
":here E_,~oU lik~~ 

f'[' F~~~'ll!!!!! M~: .. 
~===::;;:=E Click to open the Fonts dialog box. 

Use ... To ... 

Font Size Choose a font size. 

[Grab Select the application for which you want the font size changed. 
Application] 

Application Specify or confirm the application(s) for which the new font size will 
Name be used. 

Font Preview View or type text to show you the font size. 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes and close the dialog box. 

[Help] Give you information about the dialog box. 
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To change font sizes for all applications: 

1. Click Fonts in the style manager to open the Fonts dialog box. 
2. Click the Font Size option menu button to show the choices. 
3. Choose Small, Medium, or Large. 
4. Click [OK] in the Notice dialog box that opens after a font size is chosen. 
5. Click [OK] in the Fonts dialog box. 
6. Select Resume current session in the Session Startup dialog box (see 

"Specifying How You Want Your Next Session to Start" in this chapter). 
7. Log out. 
8. Log in. 

To change the font size for a specific application: 

1. Click Fonts in the style manager to open the Fonts dialog box. 
2. Click [Grab Application] to turn the pointer into a cross hair. 
3. Click an application to display its name in the Application Name box. 
4. Click a size from the Font Size menu. 
5. Click [OK] in the Notice dialog box that opens after a font size is chosen. 
6. Click [OK] in the Fonts dialog box. 
7. Select Resume current session in the Session Startup dialog box (see 

"Specifying How You Want Your Next Session to Start" in this chapter). 
8. Log out. 
9. Log in. 

You can also type the application name or class into the Application Name 
box instead of using [Grab Application] . 

Changing Workspace Backdrop Patterns 
Change the backdrop (background) pattern of each of your workspaces with the 
Backdrop dialog box. You must be in the workspace to change its backdrop 
pattern. 
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Click to open the Backdrop dialog box. 

To change the backdrop pattern of the current workspace: 

1. Click Backdrop in the style manager to open the Backdrop dialog box. 
2. Click a backdrop name to show the pattern in the viewing area. 
3. Click [Apply] to fill the workspace with the pattern. 
4. Click [Close] to close the dialog box. 

Your workstation has more patterns that don't show in the list. You can use 
the scroll bar to see what's available. You can also scroll through the backdrop 
list itself by moving the pointer over a name, holding down mouse button 1, 
and dragging through the list. 
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Modifying Your Keyboard's Behavior 
Use the Keyboard dialog box to change your keyboard's key-click volume or 
have characters repeat as long as you hold down their keys. 

[Default I 

o Auto Repeat 

o 

File !!elp 

Use ... To ... 

[Default] Return to the keyboard settings that came with your workstation. 

Click Volume Turn off key click (when at 0%) or change volume (up to 100%). 

Auto Repeat Have characters repeat while you hold down their keys. 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes and close the dialog box. 

[Help] Give you information about the dialog box. 
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To modify your keyboard's behavior: 

1. Click Keyboard in the style manager to open the Keyboard dialog box. 
2. Make your choices. 
3. Click [OK] or press (Return J. 

Modifying Your Mouse's Behavior 
Use the Mouse dialog box to change mouse button click settings, double-click 
speed, or pointer speed (acceleration and threshold). 

File 

Mouse 

¢ Right-Handed 

Q left-Handed 
.2 

Double-Click L_iiih~ ___ ", __ ~,_"J 
Click on mouse picture to test Double-Click 

2 
Acceleration LN ___ .. ' ______ '" ___ ' ______ ~,~l 

4 
Threshold [ __ ,~ ____ ,_ .. ______ ~ 

!!elp 

I!' !! r!!J,!][!!J· I!! 
~C Click to op.n the t.4ou •• dialog box. 
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Use ... To ... 

[Default] Return to the mouse settings that came with your workstation. 

Right-Handed Use standard settings for mouse button clicks. 

Left-Handedl Reverse standard settings for mouse button clicks. 

Double-Click Change double-click time from .1 to 1.0 seconds. To test, 
double-click the mouse picture in the dialog box. 

Acceleration Change mouse pointer speed. The slider values are multipliers that 
range from zero to 10. For example, at "2," the pointer moves twice 
as fast as the mouse when the mouse is moved. New speed works 
immediately. 

Threshold Change the distance the pointer moves at a slow speed in a short 
amount of time before the pointer moves at the "accelerated" rate. 
Threshold adjustments allow the mouse to be used for precise 
alignment when it is moved slowly, yet it can be set to travel across 
the screen quickly at the accelerated speed, when desired. 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes and close the dialog box. 

[Help] Give you information about the dialog box. 

1 H you reverse mouse button settings, don't get caught in the "mouse trap." When Le£t-Banded is 
selected, mouse button 3 works for actions instead of mO'ILse button 1. To escape the mousetrap, 
choose Right-Banded or click [Cancel] using mouse button 3. 

To modify mouse behavior: 

1. Click Mouse in the style manager to open the Mouse dialog box. 
2. Adjust the settings. 
3. If you change Double-Click, click [OK] in the Notice dialog box that opens. 
4. Click [OK] or press (Return) in the Mouse dialog box. 
5. If you've changed Double-Click, select Resume Current Session in the 

Session Startup dialog box (see "Specifying How You Want Your Next 
Session to Start" in this chapter). 

6. Log out. 
7. Log in. 
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You can use the Vuestyle*writeXrdblmmediate resource to avoid having to 
to log out and log back in after changing double-click speed. However, the new 
speed is used only in applications started after the speed is changed and [OK] 
is clicked. See "Adding Resources to the Resource Database" in Chapter 8). 

Adjusting Audio 
Change the volume, tone, and duration of your workstation's beeper with the 
Audio dialog box. 

c::Il Audio 

• rD;;t~UitJ 

50 

400 

.1 

File 

r_n 
! Color Fonts 

Click to open the Audio dialog box. 
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Use ... To ... 

[Default] Return to the audio settings that came with your workstation. 

Volume Turn off beeper sound (when at 0%) or change volume (up to 100%). 

Tone Change beeper tone (pitch) from 82 to 9000 Hertz. 

Duration Change beeper length from .1 to 2.5 seconds. 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes and close the dialog box. 

[Help] Give you information about the dialog box. 

To modify audio: 

1. Click Audio in the style manager to open the Audio dialog box. 
2. Adjust the settings. 
3. Click [OK] or press [Return ). 

Specifying Screen Saver Time Out Intervals 
If you have a color display, bright colors on the screen for long periods of time 
can "burn" into the picture tube. A time out-when the screen goes blank or 
displays an X logo-prevents this from happening. 

To redisplay your workspace during a time out, move the mouse or strike a key. 
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Use ... 

[Default] 

Logo 

Screen Saver 

Time Out 

[OK] 

[Cancel] 

[Help] 

.... 1 Screen 

• o Logo 

o Screen Saver 

10 

!!elp 

Ii!! !!ll!l~r-!!lfll! II!! 
Click to openthe Screen dialog box. I=~===~==~:U 

To ... 

Return to the screen settings that came with your workstation. 

Display an X logo during a time out instead of a blank screen. 

Turn screen saver on or off. 

Choose the time interval (from 1 to 120 minutes) from the last 7 
pointer move or keystroke to when the screen blanks out or displays 
an X logo. 

Save changes and close the dialog box. 

Cancel changes and close the dialog box. 

Give you information about the dialog box. 
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To modify screen saver: 

1. Click Screen in the style manager to open the Screen dialog box. 
2. Adjust the settings. 
3. Click [OK] or press CRetUmJ. 

Allowing Hosts to Show Information on Your Workstation 
A host is a workstation on the network, and a host name is the name by which 
that workstation is known. If you are on a network, you can control which 
hosts can display information on your workstation by adding them to a list in 
the Hosts dialog box. 

~I Hosts 

• Hosts Allowed-

vAil hosts 

<> Listed hosts 

hpchmle I~ hpkreta i 
hppatti I 
hpanna 
hpdex i 

~=~JJ 
I~~ ___ .A" I 

I Add I I-Delete I 

~ rcancea] ~ 

!:!elp 

BJ~ _,-1 
Mouse ~ ~s;:JL;;;J 
Click to open the Hosts dialog box. :J 
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Select ... To ... 

All hosts Permit any host to display information. 

Listed hosts Permit only listed hosts to display information. 

[Add] Add a host name to the list. 

[Delete] Delete a host name from the list. 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes and close the dialog box. 

[Help] Give you information about the dialog box. 

To add a host to the list: 

1. Click Hosts in the style manager to open the Hosts dialog box. 
2. Click the box above [Add] to display the text insertion cursor. 
3. Type the host name. 
4. Click [Add] to add the host to the list. 
5. Click [OK]. 

To delete a host from the list: 

1. Click Hosts in the style manager to open the Hosts dialog box. 
2. Click the host name you want to delete. 
3. Click [Delete]. 
4. Click [OK]. 

The name is removed from the list, but remains in the text box to give you a 
chance to add it back. Click [Add] ... to add it back to the list. 
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Specifying How You Want Your Next Session to Start 
Each time you log into HP VUE, you begin a session; the session lasts until you 
log out. 

File 

Session Startu 

• At login:------..... 

<> Resume current session 

V Return to Home session 

V Ask me at logout 

[ logout Confinnotion Dialog: 1 
<> On <)Off 

Click to open the Session Startup dialog box. 
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Select ... To ... 

Resume current Start your next session the way you left your last one, including 
session any setting, client, or resource modifications. 

Return to Home Start the session you've designated as the one you can always 
session go back to, no matter what modifications you've made. 

Ask me at Logout Have your workstation ask you when you logout how you want 
your next session to start. 

Logout When set to On, your workstation displays a dialog box asking 
Confirmation you to confirm that you want to log out. 
Dialog 

[Set Home Make your current session your home session. You may want to 
Session ... ] do this when you've modified colors or backdrops, for example. 

[OK] Save changes and close the dialog box. 

[Cancel] Cancel changes (except if you've set a new home session) and 
close the dialog box. 

[Help] Give you information about the dialog box. 

Your Current and Home Sessions 

Whenever you are logged into HP VUE, you are working in a current session. 
By default, when you log out, HP VUE will save your current session and 
restore it the next time you log in. 

HP VUE also lets you save a home session. The home session is a known state 
you can always return to, regardless of what you do during the current session. 

To save the current session as your home session: 

1. Set up your current session the way you want your home session to come up. 

2. Click Startup in the style manager. 

3. Click [Set Home Session ... ], and click [OK] in the displayed warning 
dialog box. 
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Choosing Which Session to Return To 

To modify session startup: 

1. Click Startup in the style manager to open the Session Startup dialog box. 
2. Make your choices. 
3. Click [OK] or press (R'etijffl). 

If you select Ask me at Logout, then Logout Confirmation Dialog is 
automatically set to On. If you set Logout Confirmation Dialog to Off, the 
dialog box automatically selects Resume current session. 

7 -24 Tailoring Your Environment with Style 



8 
Advanced Customizing 

Using HP VUE's graphical interface, you can directly customize much of your 
workspace appearance and behavior. Other elements require you to edit ASCII 
configuration files. This chapter is about editing those files. 

Customizing HP VUE is covered in much more detail in the HP Visual User 
Environment System Administration Manual. 

8 



Watch Out for These "Gotchas" 
Before you begin editing any configuration file, make a backup copy of the file 
and store it in a safe place. That way you have something to return to in case 
something-shall we say "unexpected" -happens. 

As you edit a configuration file, watch out for these "gotchas." 

• The operating system is case sensitive. A file named sys. vuewmrc is not the 
same file as sys. VUEwmrc. 

• The number "I" (one) is not the same as the lower case "I" (el). They look 
similar to us, but the workstation will have no problem telling them apart. If 
you're typing /usr/lib/X11, you need to type "X one one," not "X el el." 

• The number "0" (zero) is not the same as upper case "0" (oh) for the same 
reason. 

Adding Resources to the Resource Database 
At login, the HP VUE managers establish an internal database of resources to 
control their appearance and behavior. 

There are two ways to add and modify resources in the resource database: 

• Using the built-in RES_EDIT action . 

.. Using the X Window System command xrdb. The xrdb command reads an 
ASCII text resource file into the internal resource database. 

You can find a list of resources for each HP VUE manager in the man page 
for that manager in the help index (click Command Reference (Man Pages), 
then Standard Operating System Commands, then search for vue manager ). 
For more information on resources in general and how to use them, see the HP 

I 8 Visual User Environment System Administration Manual. For information on 
xrdb see the xrdb man page. 
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Using RES_EDIT to Change Resouces 

To change resources using the RES_EDIT action: 

1. Open a view of your system_adm/Xll_apps folder: 

a. Display the applications directory (click the applications directory button 
in the workspace manager). 

h. Double-click system_apps, then Xl1_apps, to switch to the subdirectory 
containing the RES_EDIT action icon. 

2. Double-click the RES_EDIT action icon. 

The action uses xrdb to create a temporary file containing the contents of 
the current resource database contained in your X server. It then runs your 
default editor with the temporary file. 

3. Edit the file to contain the resources you want. You can add new resources, 
or modify or remove existing resources. 

4. Save the file you are editing. 

5. Exit the editor. If the editor is running in an hpterm window, close the 
window. 

The action writes the contents of the temporary file to the resource database 
and then removes the temporary file. 

Using 'xrdb' to Change Resources 

To add resources to the resource database using 'xrdb': 

1. Create a resource file in your home directory using an ASCII text processor. 
2. Add one line to the file for each resource you want to set. 
3. Save the resource file and exit your text processor. 
4. Type xrdb -nocpp -merge vuedefs CRetUffi) at the command-line prompt of a 

local terminal window. 

To have the new resources effect subsequent sessions, log out saving your 
current session, then log back in. 
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For example, you can create a vuedefs resource file to: 

• Select an active window by moving the pointer into it without clicking. 
• Add the iconbox. 
• Make font changes and changes to the mouse double-click time take effect on 

newly started applications (without having to logout first). 

To achieve this, your vuedefs file would contain the following lines: 

Vueva*keyboardFocusPolicy: pointer 
Vueva*uselconBox: True 
Vuestyle*vriteIrdbImmediate: True 

You would merge vuedefs into the resource database by typing the following 
command in a terminal window: 

xrdb -nocpp -merge vuedefs (Retijffi) 

To see the changes, restart the workspace manager and the style manager. 

Caution , Adding some resources to your vuedefs might impair the 
usefulness of some HP VUE managers. For example, adding 
color resources to your vuedefs file will impair the operation of 
the style manager's Color dialog box. 

Customizing the Workspace Manager Layout 
The layout of the workspace manager is specified in the vuewmrc file. To 
customize the layout, you must have a vuewmrc file in the. vue folder of your 
home directory. 

Getting a vuewmrc File 

Use a file manager to view your "hidden" . vue folder: 

1. Open a file manager view of your home directory. 
2. Choose Filter ... from the View menu. 
3. Click [Show Hidden Files] if the button isn't already selected. 
4. Click [Apply] to change the file manager view to show hidden files. 
5. Double-click the . vue icon to view its contents. 
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If you don't find a vuewmrc file, copy the system vuewmrc file to . vue: 

1. Open a second file manager view. 
2. Change to the /usr/lib/Xii/vue/Vuewm folder. 
3. Drag a copy of sys . vuewmrc to your . vue folder. 
4. Choose Rename ... from the File menu. 
5. Edit the New File Name box to rename the file vuewmrc. 
6. Click [OK]. 

Change the write permission so that you can modify vuevmrc: 

1. Click vuewmrc if the file isn't already selected. 
2. Choose Properties ... from the File menu. 
3. Click the write permission for Owner to make vuewmrc writable (so you can 

modify it in your text processor). 
4. Click [OK] to close the File Properties dialog box. 

Understanding the Workspace Manager Syntax 

The vuewmrc file uses the keyword FrontPanel for the workspace manager 
"front panel." All FrontPanel rows have the same syntax. 

# FrontPanel Description 

FrontPanel PanelName 
{ 

Row RowName 
II Name II [buttontype] [bitmaps] [widthx height] function 
II Name II [buttontype] [bitmaps] [widthx height] function 

} 

Workspace Manager Examples 

Files in the the directory /usr /lib/Xii/vue/ examples/Vuewm contain 
examples of other workspace managers. If you are thinking about customizing 
your workspace manager, you may want to examine these files for ideas. The 
README file in the directory contains a description of each file. 
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Removing a Control from the Workspace Manager 

To remove a control, delete the line in vuewmrc that creates that control for 
your display resolution. You may need to adjust the size of other elements in 
compensation, for example, by adding more ribbing. 

After you modify vuewmrc, restart the workspace manager by choosing 
Restart Vuewm . .. from the workspace menu. 

Adding Applications and Indicators to the Workspace Manager 

You can add an application to the workspace manager by creating an 
application bitmap, then adding an application push button to the workspace 
manager. You can add an indicator by adding an indicator button to the 
workspace manager. 

Creating an Application Bitmap 

Many commercial applications come with bitmaps for icons and other uses. If 
the application you're adding falls into this category, you need only know the 
name of the bitmap and where it is located to proceed. 

If the application you're adding doesn't have its own bitmap, you must create a 
bitmap to use as the icon on the workspace manager push button. One way to 
do this is to use the bitmap editor included in your application directory. To 
start the editor: 

1. Click the application directory push button in the workspace manager. 
2. Double-click the system_apps icon. 
3. Double-click the X11_apps icon. 
4. Double-click the BITMAP icon. 
5. Type the name of your new bitmap in the File To Edit entry box in the 

dialog box that appears. 
8 6. Type the width of the bitmap in the Width entry box. 

7. Type the height of the bitmap in the Height entry box. 
8. Click [OK]. 

The size you make your bitmap depends on the resolution of your display and 
the workspace manager row you want to put it in. 
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Display Bitmap Workspace Manager 
Resolution Size Row 

High (1280x 1024) 88x70 top 

High (1280x1024) 65x28 bottom 

Medium (1024x768) 72x55 top 

Medium (1024x768) 51x22 bottom 

Also, the workspace manager adds a two-pixel wide frame around bitmaps, so 
when figuring bitmap width and height, your bitmap should be 4. pixels smaller 
than the allotted space. 

For more information on using bitmap, see the bitmap man page in the help 
manager (click Man Pages, then Standard HP-UX Commands, then search for 
bitmap). The bitmap client is also covered in the manual Using the X Window 
System. 

Once you have created the bitmap file, you must place it in a directory where 
the workspace manager can find it. The default location for workspace 
manager bitmaps is /usr/lib/X11/bitmaps/Vuewm. You can specify a different 
location by using the absolute path when you specify the bitmap file in your 
vuewmrc file. 

Adding an Application to the Workspace Manager 

Once you have a bitmap, you need to select the right place in vuewmrc to insert 
the application push button. 

To add an application to the workspace manager top row, insert the push 
button line after the { following Row Top but before the } before Row Bottom. 
Items appear on the workspace manager in the sequence in which they are 
listed in the FrontPanel specification. . 81. 

I 

I 
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To add an application to the workspace manager: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line FrontPanel LargeFrontPanel if your display has a 

resolution of 1280x1024. If your display has a resolution of 1024x768, search 
for the line FrontPanel MediumFrontPanel. 

4. To add an application, insert the push button line at the appropriate 
location in vuewmrc. 

5. Save the vuewmrc and exit your text processor. 
6. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 

For example, in a high resolution display, to replace the blank ribbing to the 
left of the terminal window with an application, replace this line: 

vuevmrib [I] =65 

with this line: 

lIyApplame [T] I/path/myappbitmap.bm =65::1:28 :f.euc "application t" 

Adding and Removing Workspaces 

The workspace manager keeps the number of workspaces internally in the 
resource database. However, you can add to or delete workspaces from the 
resource database by including the following line in your personal vuedefs 
resource file: 

Vuevm*ResolutionColor*llorkspaceList: Name1 Name2 NameS NameN 

Values for Resolution Include Values for Color Include 

Mono 

LowRes LowColor 

MedRes MedColor 

HighRes HighColor 
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ResolutionColor is a compound word composed of a resolution value and a 
color value. For example, a high resolution workstation (1024x768) with a 
256-color screen would be HighResHighColor. 

To find the ResolutionColor for your workstation, open a terminal window and 
type: 

xrdb -q (Return) 

When the contents of the resource database print in the terminal window, 
look for the Vuewm*ResolutionColor*workspaceList line and use the 
ResolutionColor value in your vuedefs file. 

You can have a minimum of one workspace; the maximum depends on the 
amount of memory on your workstation. 

To change the number of workspaces: 

1. Create a vuedefs resource file in your home directory using an ASCII text 
processor. 

2. Type the following line into your resource file: 

Vuewm*ResolutionColo7'*vorkspaceList: Namel Name2 Name!] NameN 

where each Name is the unique name of a workspace. The number of names 
you enter will be the number of workspaces in your workspace manager. 

3. Save the resource file and exit your text processor. 
4. Type the following at the command-line prompt of a local terminal window: 

xrdb -nocpp -Illerge vuedefs [Return) 

1'0 see the results of your modification, restart the workspace manager (drag 
the workspace (root) menu and choose Restart Vuewm ... ). 
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Customizing Your HP VUE Menus 
To customize an existing menu, or invent a new menu, you must have a 
vuewmrc file in the . vue directory folder of your home directory. 

Use a file manager to view your. vue folder. If you don't find a vuewmrc file, 
copy the system vuewmrc file to . vue. See "Getting a vuewmrc File" above. 

Understanding Menu Syntax 

All vuewmrc menus have the same syntax. 

# Menu Description 

Menu MenuName 
{ 

} 

"Item Oneil [mnemonic] [accelerator] function 
"Item Two" [mnemonic] [accelerator] function 

Adding or Removing Items from Menus 

Adding or removing items from any of the vuewmrc menus is only a matter of 
inserting or deleting a line into the appropriate menu. 

To add an item to the workspace menu: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line Menu VueRootMenu. 
4. Insert your addition to the menu anywhere after the opening { but before 

the closing}. Items appear in the workspace menu in the sequence in which 
8 they are listed in VueRootMenu. 

5. Save vuewmrc and exit your text processor. 
6. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 
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For example, if you want the first item of your workspace menu to start emacs, 
insert this line at the top of the VueRootMenu list: 

"Start emacs" f.exec "emacs t" 

To add an item to the window menu: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line Menu VueWindowMenu. 
4. Insert your addition to the menu anywhere after the opening { and before 

the closing}. Items appear in the window menu in the sequence in which 
they are listed in VueWindowMenu. 

5. Save vuewmrc and exit your text processor. 
6. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 

To remove an item from the workspace menu: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line Menu VueRootMenu. 
4. Delete the line (any line between the opening { and closing }) you want to 

remove. 
5. Save the vuewmrc and exit your text processor. 
6. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 

To remove an item from the window menu: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line Menu VueWindowMenu. 
4. Delete the line (any line between the opening { and closing}) you want to 8 

remove. 
5. Save the vuewmrc and exit your text processor. 
6. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 
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Making Your Own Workspace Menus 

You can invent custom menus for your unique workspace environment by first 
creating a menu definition in vuewmrc and then binding the appearance of the 
menu to a keystroke or mouse button action. 

To make a custom menu: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Move the insertion cursor to the first blank line above the line # Key 

Binding Descriptions. 
4. Insert a blank line. 
5. Type a comment line for maintenance purposes describing your custom 

menu. 
6. On the second line, type the Menu keyword followed by a space and the 

name of your new menu. 
7. On the third line, type an open {. 
8. On the fourth line, type your first menu item. 
9. On the fifth line, type your next menu item. 

10. On the line following your last menu item, type a closing }. 
11. Bind the menu to a keystroke or mouse button action (see "Customizing 

Mouse and Key Bindings" later in this chapter). 
12. Save the vuewmrc and exit your text processor. 
13. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 

For example, if you want to add a VIP Menu for your very important programs, 
the menu definition might look something like the following: 

I MyVIP menu description £or £requently used text and spreadsheet £iles. 

Menu MyVIPMenu 
{ 

"VIP Menu" £. title 
"Letters" £.exec "emacs /users/mylogin/letters/ t" 
"Reports" £.exec "emacs /users/mylogin/reports/ tot 
"1990 Budget" £.exec "spread /users/mylogin/budget/bud90.vks tot 
"1991 Budget" £.exec "spread /users/mylogin/budget/bud91.vks tot 
"5 Year Plan" £.exec "spread /users/mylogin/5yrplan/5yraaster.vks tot 
} 
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You can find a complete list of menu functions in the vuewmrc (4) man page in 
the help index (click Man Pages, then Formats of Important System Files, 
then search for vuewmrc). For more information on customizing vuewmrc 
menus, see the HP Visual User Environment System Administration Manual. 

Creating Your Own File Types and Action Definitions 
HP VUE includes a file type database and an actions database. The file type 
database is used by HP VUE to classify files into different types. For example, 
the file manager uses file types to display different icons for data files and 
executable files. 

You can then create action definitions in an actions database and associate the 
definition with certain file types. VIEW and EDIT in the file manager's Actions 
menu are examples of HP VUE action definitions. 

You can create personal file types and action definitions by creating a file types 
database and an actions database in your. vue/types folder. You can also 
create executable actions based on your action definitions, storing their icons in 
your . vue/types/tools folder for easy access. 

Examples of File Types and Action Definitions 

Files in the the directory /usr/lib/X11/vue/examples/types contain 
examples of file types and action definitions. If you want to customize your 
database by adding new file types and actions, you may want to examine these 
files for ideas. The README file in the directory contains a description of each 
file. 

Examining the System Files 

Another way to learn about creating personal file types and action definitions 
is to examine the system files. The system files are located in either 
/usr/lib/X11/vue/types or /usr/local/lib/X11/vue/types. 
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Caution , Except for user-prefs • ad, do not copy *. ft and *. ad files 
to your home directory. Personal copies of these files take 
precedence over the system copies, blocking you from receiving 
improvements made in future releases. 

Modifying an Action 

Many HP VUE actions are made by associating (mapping) a general action to 
a more specific action. For example, the general action PRINT is associated 
by default with the specific action PRINT _PR, the equivalent of the operating 
system command pr IIp. To modify an action like PRINT, therefore, you 
simply associate it with a different specific action. 

To modify the PRINT definition: 

1. Copy /usr/lib/Xll/vue/types/user-prefs. ad to 
$HOME/. vue/types/login. ad. You can use any name for the file 
as long as the name ends with the extension. ad. 

2. Choose Properties ... from a file manager File menu. 
3. Click the write permission for Owner to make login. ad writable (so you can 

modify it in your text processor). 
4. Click [OK] to close the File Properties dialog box. 
5. Start your text processor and open login. ad. 
6. Delete the print action that appears after MAP on the PRINT definition. 
7. Type any valid print action in its place. 
8. Save the file and exit your text processor. 
9. Reread the database of action definitions: 

a. Click on the Applications Directory button in the workspace manager to 
display a file manager view of the applications directory. 

b. Double-click system_apps to switch to the system-apps directory. 
c. Double-click sys_admin to switch to that directory. 
d. Double-click REREAD_DB to execute the reread-database action. 
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Valid Print Equivalent Command Description 
Actions 

PRIITER_IIFO lpstat -d -r -u Displays printer status. 

PRIIT_PR pr filename I lp Paginates, then prints a file. 

PRIIT_IOPR lp filename Prints a file without paginating. 

To view a complete list of valid print actions, open a view of your 
. vue/apps/system_apps/print folder. To modify other action definitions, 
follow a similar process. 

Creating Your Own File Types 

To create your own file types, create file type definitions in an ASCII text file, 
login. ft, in $HOME/ . vue/types. You can use any name for the file as long as 
the name ends with the extension .ft. 

Syntax for File Types 

File type definitions have the following syntax: 

# Description 
FileTypeName FileTypePattern Mode LIcon SIcon ActionList 

To improve readability, you can use the backslash character \, as in the 
following syntax, to make the definition span several lines. Note, however, that 
the \ must be the last character on the line, that is, not followed by any spaces, 
tabs or other characters. 

# Description 
File TypeN ame \ 
File TypePattern \ 
Mode \ 
LIcon \ 
SIcon \ 
ActionList 
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Description A comment describing your file type. Comments must begin 
with a • in the left margin. 

FileTypeN ame The name of this file type, used in the action database files to 
specify this file type. 

FileTypePat- The distinguishing naming convention that identifies a file of 
tern this type. 

Mode A single- or multi-character expression specifying the file 
properties pertaining to this file type. Single characters 
include: directory, executable, readable, writable. 
Multi-character expressions are composed of single characters 
linked by ! (boolean "not") and I: (boolean "and"). 

LIcon The bitmap you'll use for this file type in the file manager's By 
Name and Icon viewing preference. 

SIcon The bitmap you'll use for this file type in the file manager's By 
Name and Small Icon viewing preference. 

ActionList The list of actions that appear in the file manager's Actions 
menu when you select a file of this type. Separate actions in 
the list with commas. 

The following conventions apply: 

• Each file type definition must be on a separate line. 
• If you use the \ to span several lines with a file type definition, make sure 

the \ is the last character on the line. 
• The first action in the action list is the default action (invoked by 

double-clicking or dropping the icon on the workspace backdrop). 
• Each task in the action list must have a corresponding entry in an action 

database file. 
• Do not put spaces or tabs in the mode expression. 

Choosing a Good File Type Pattern 

File type patterns are checked using the complete path of the file, starting with 
the host name. 
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The easiest file type patterns to create are one or two character "dot" 
extensions to the file name where the host, path, and file name are specified by 
the "wild card" *. This avoids excessive heart palpitations when files are "lost" 
because the hostname was inadvertently left off the path. A * at the beginning 
of the file type pattern says "match any path". Many files such as C language 
header files (which end in .h) and C source code files (which end in . c) already 
use this convention. Their file type patterns would be *.h and *. c. 

The order in which you list the file types is important, because when the 
database is searched, the first match is used. Thus, if the filename patterns for 
two different file types overlap, you must specify the more specific one first. For 
example, *. bm must be listed before *. b*. 

The following list shows various file type patterns and what they match on 
HP-UX systems: 

*.c Matches any file ending in . c. 

hostname : * . c Matches any file on hostname ending in . c. 

*/ filename. c Matches files on any host, any path named filename. c. 

Matches any files on any host with the specified path (or 
subdirectory underneath path) and ending in . c. 

Creating a File Type Definition 

When creating a new file type definition, use an existing file type definition as 
a template. You can view file type definitions by opening a file manager view 
of /usr/lib/Xll/vue/types/, selecting vue. ft, and choosing VIEW from the 
Actions menu. 

To create a login.ft file: 

1. Open a file manager view of your . vue/types folder. 
2. Choose New. .. from the file manager's File menu. 
3. Click the New Data File Name entry box to display the insertion cursor. 
4. Type the name of the file: login. ft. 
5. Click [OK] or press (Retijffi). 
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To create a file type definition: 

1. Open login. ft in your text processor. 
2. Start your description by typing # in the left margin and then your 

comment. 
3. On the next line, type the file type name, pattern, mode, large icon, small 

icon, and action list. 
4. Save login. ft and exit your text processor. 
5. Reread the database of file types definitions: 

a. Click on the Applications Directory button in the workspace manager to 
display a file manager view of the applications directory. 

b. Double-click system_apps to switch to the system-apps directory. 
c. Double-click sys_admin to switch to that directory. 
d. Double-click REREAD_DB to execute the reread-database action. 

For example, suppose you have a spreadsheet program that produces data files 
with the extension of . wks. You could create the following file type definition: 

I File type definition for my spreadsheet •. vks files 
SPREADSHEET \ 

•. vks \ 
!d \ 
vks.l.bm \ 
vks.s.bm \ 
EDIT 

Once you create a file type, you can use it in an action definition. 

Creating Your Own Action Definitions 

Action definitions are contained in action database files and can be associated 
with file types. Each definition can also have a corresponding executable file 
icon (in the appropriate ... /types/tools folder) and appear in the file 
manager Actions menu when you select a file of the associated file type. 

Syntax for Action Definitions 

Each action definition is on a separate line in a file ending in the extension . ad. 
Keep your personal action definitions in a login.ad file in your . vue/types 
folder. Keep the executable action icon in your . vue/types/tools folder. 
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An action definition has one of the following syntaxes: 

size 
I Description 
ACTIONNAME FileTypes LIcon SIcon COIUUID WinType ExecHost ExecString 
ACTIONNAME FileTypes LIcon SIcon IUP ACTIONNAME 

Description 

ACTION­
NAME 

File Types 

LIcon 

SIeon 

COMMAND 

Win Type 

ExecHost 

Exec String 

MAP 

ACTION­
NAME 

A description for your action definition. The line must begin 
with a • in the left margin. 

The name of the action. This will appear as a choice in the 
Actions menu and as the label of the executable action icon. 

The file types that you want associated with this definition. 
Separate file types with a comma (,) or a pipe (I). 

The bitmap you'll use for the definition in the file manager's By 
Name and Icon viewing preference. 

The bitmap you'll use for the definition in the file manager's By 
Name and Small Icon viewing preference. 

Executes a command or application. 

Starts the appropriate type of terminal window. 

The host on which to execute the action. Use Y.LocaIHostY. for 
your workstation. 

The command to execute. 

Associates a generic action with a specific action. 

The name of the specific action to associate with this general 
action definition. 

WinTypes can have one of the following values: 

NO-STDIO 

TERMINAL 

No window created; command creates its own window. 

Creates a temporary terminal window that closes when the 
command finishes executing. 

PERM-TERMINAL Creates a permanent terminal window that does not close 
when the command finished executing. 
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SHARED-OUTPUT Uses the shared output window. (SHARED-OUTPUT is not 
implemented on Domain/OS). 

OUTPUT-ONL Y Creates an output-only window. 

ExecHost can have one of the following values: 

host 

1.LocalHost1. 

1.DataHost1. 

1.DatabaseHost1. 

1. II prompt" 1. 

Executes the command on this host. 

Executes the command on your local workstation. 

Executes the command on the host where the data files 
are located; your workstation, if no 1.DataHost1. is 
specified. 

Execu tes the command on the host on which the action 
was defined. 

Prompts for a host on which to execute the command. 

To improve readability, you can use the backslash character \, as in the 
following syntax, to make the action definition span several lines. Note, 
however, that the \ must be the last character on the line, that is, not followed 
by any spaces, tabs or other characters. 

# Description 
ACTIONNAME \ 
FileTypes \ 
LIcon \ 
SIcon \ 

The following conventions apply: 

• An action definition file must end in . ad. 
• Each action definition must be on a separate line. 

a • If you use the \ to span several lines with a definition, make sure the \ is the 
last character on the line. 

• Each file type in the definition must have a corresponding entry in the file 
type database. 

8-20 Advanced Customizing 



Creating an Action Definition 

When creating a new action definition, use an existing definition as 
a template. To view action definitions, open a file manager view of 
/usr/lib/Xll/vue/types/, select an appropriate. ad file, and choose VIEW 
from the Actions menu. 

To create an action definition: 

1. Create a file called login.ad in your $HOME/. vue/types directory. It really 
doesn't matter what you call the file, as long as the extension is . ad. Here, 
your login name is used. 

2. Create a variable for the action's large icon and give it the name of the 
bitmap to use by typing: set ACTION_L=bitmap To use the standard HP 
VUE bitmap, type set ACTION_L=action.l. bm. 

3. Create a variable for the action's small icon and give it the name of the 
bitmap to use by typing: set ACTION_S=bitmap To use the standard HP 
VUE bitmap, type set ACTION_S=action. s. bm. 

4. Type a comment, beginning with a # in the left margin. 
5. On the next line, type the ActionN arne, FileTypes, large icon, small icon, 

ExecHost, and the rest of the action definition. 
6. Save login.ad and exit your text processor. 
7. Repeat steps 4 and 5 for each additional action you want to create. 
8. Reread the database of action definitions: 

a. Click on the Applications Directory button in the workspace manager to 
display a file manager view of the applications directory. 

b. Double-click system_apps to switch to the system-apps directory. 
c. Double-click sys_admin to switch to that directory. 
d. Double-click REREAD_DB to execute the reread-database action. 

Caution 

I 
When creating an action definition for a shell script, the last 
command does not execute when in background (followed by an 
ampersand (&)). If you must use an ampersand after the last 
command, follow the command with the line sleep 5. 
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To create an executable action icon: 

1. Open a file manager view of $HOME/ . vue/types/tools. 
2. Choose New... from the file manager's File menu. 
3. Type the name of your action definition in the New Data File Name box. 
4. Select the file. 
5. Choose Properties from the File menu. 
6. Click the execute permissions to make the file executable. 
7. Click [OK]. 

You can now drop a file of the associated type onto the executable icon to 
invoke the appropriate action. 

You can make copies of executable action icons in different directories. That 
way, the action can be accessed from more than one directory. 

To copy an executable action icon: 

1. Open a file manager view of the directory containing the executable action 
icon. 

2. Open a file manager view of the the destination directory. 
3. Copy the executable action icon by dragging it to the destination directory 

(using (Ctrl)+mouse button 2). 

Examples 

You could turn the operating system more command into an action definition 
so that, when you dropped files on your MORE action, terminal windows would 
appear using the more command to view the files. Your login.ad action 
database would look like the following: 

set ACTIOI_L=action.l.bm. 
set ACTIOI_S=action.s.bm. 

I This MORE views dropped £iles. 
8 MORE \ 

* \ 
${ACTIOI_L} \ 
${ACTIOI_S} \ 
COMMAID \ 
PERM-TERKIIAL \ 
'~oca1Host% \ 
more %(File)Arg_l% 
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You could create a MORE action in login.ad that enabled you to double-cli.ck the 
MORE icon and have it prompt you for a file name with this action definition: 

• This KORE vievs dropped £iles 
• and prompts £or £iles when double-clicked. 
KORE \ 

* \ 
${ACTIOI_L} \ 
${ACTIOI_S} \ 
COKKllD \ 

PERII-TEBKUll \ 
%!,ocalHost% \ 
more %(File)Arg_l"Enter £ile to display:"% 

Or, if you had a spreadsheet program that produced data files with the 
extension of . wks, you could create the following action definition. Dropping 
a spreadsheet file on the action icon would start the spreadsheet with the file 
open in it. 

• Action de£inition £or my spreadsheet program. 
SPREADSHEET \ 

*.wks \ 
vks.big.bm \ 
vks.tiny.bm \ 
COKKUD \ 

%!'ocalHost% \ 
sheets %(File)Arg_l% 

Customizing Mouse and Key Bindings 
HP VUE operations are equated with mouse button actions or keystrokes in 
the vuewmrc file in the . vue directory folder of your home directory. 

Use a file manager to view your . vue directory. If you don't find a vuewmrc 
file, copy the system vuewmrc file to . vue (see "Getting a vuewmrc File" earlier 
in this chapter). Use the File Properties dialog box, if necessary, to make 
vuewmrc writable. 
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Understanding Mouse Button and Key Binding Syntax 

I Button Description 

Buttons BindingSet 
{ 

} 

button context junction 
button context junction 
button context junction 

I ley Description 

18ys BindingS et 
{ 

} 

key context junction 
key context junction 
key context junction 

You can find a complete list of functions in the vuewmrc man page in the help 
index (click Man Pages, then Formats of Important System Files, then search 
for vuewmrc). For more information on customizing mouse button and key 
bindings, see the HP Visual User Environment System Administration Manual. 

Customizing Mouse Button Bindings 

Since mouse button 1 is used for selection and mouse button 2 is used for 
moving, if you need a special operation that requires a mouse button action, 
such as adding a custom menu to the workspace, bind the operation to a 
button 3 action. 

To add an operation to mouse button 3: 

8 1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line Buttons VueButtonBindings. 
4. Insert your addition to the button binding set anywhere after the opening { 

and before the closing}. The addition must be a unique binding. 
5. Save the vuewmrc and exit your text processor. 

8·24 Advanced Customizing 



6. To see your change, drag the workspace menu and choose Restart 
Vuewm .... 

For example, if you want to add a mouse button action to display the VIP 
menu from "Making Your Own Workspace Menus" above, change this line: 

<Btn3Down> root f.menu VueRootMenu 

to this: 

<Btn3Down> root f.menu MyVIPMenu 

Customizing Key Bindings 

The procedure for customizing a key binding is very similar to customizing 
mouse button bindings: 

To add a key binding: 

1. Make a backup copy of vuewmrc. 
2. Call up vuewmrc in your favorite ASCII text processor. 
3. Search for the line Buttons VueKeyBindings. 
4. Insert your addition to the key binding set anywhere after the opening { and 

before the closing}. The addition must be a unique binding. 
5. Save the vuewmrc and exit your text processor. 
6. To see your change, drag the workspace menu and choose Restart 

Vuewm .... 

For example, if you want to add a (Meta) 0 keystroke action to display the VIP 
menu from "Making Your Own Workspace Menus" above, insert this line: 

Meta<Key>V root f.menu MyVIPMenu 

Each time you press the (Meta) key followed by 0 (the (Meta) key is 
immediately to the left of the space bar; (Extend char) on some keyboards) with 
the pointer on the workspace, your VIP menu will post to the workspace. 8 
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The Vuepad Editor 

The vuepad editor is an easy-to-Iearn text editor appropriate for small editing 
tasks such as writing memos and editing resource files. This appendix covers 
how to open, edit, and save files using vuepad. 

Starting 'vuepad' 
There are several ways to start vuepad: 

II Using the vuepad icon in the Applications directory. 
III From a command line in a terminal emulator window. 
III If vuepad is your default editor, vuepad starts when you double-click a data 

file, or when you select the data file and choose EDIT from the Actions 
menu. Making vuepad your default editor is covered later in this appendix. 

Starting 'vuepad' Using Its Icon 

The vuepad icon is located in the Applications directory. 

To display the vuepad icon: 

1. Click the applications directory button to display the applications directory. 

-=::o~e II ::e II~II ~ II~II[I~I 
J~.===ij"._: iil~~.....J~!!5iii 

Click to open a File Manager view of the Applications directory :J 
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2. Double-click system_apps. 
3. Double-click edit. 

VEDIT VI VUEPAD • 

To start 'vuepad' with an empty tablet: 

1. Display the vuepad icon in the Applications directory. 
2. Double-click the icon. 

To start 'vuepad' with a document in the tablet: 

1. Display the vuepad icon in the Applications directory. 
2. Get a file manager view of the directory containing the document. 
3. Drag the document icon to the vuepad icon. 

Creating Copies of the 'vuepad' Icon 

You can create copies of the vuepad icon in directories where you frequently 
edit files. The copy behaves exactly like the icon in the Applications directory. 

To make a copy of the icon: 

1. Open two file manager views: 
a. Display the VUEPAD icon in the Applications directory in one file 

manager. 
b. Display the target directory in the other file manager. 

2. Hold down (CTRL) and mouse button 2 and drag a copy of the icon from the 
Applications directory to the target directory. 
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The 'vuepad' Window 
The vuepad window contains: 

III Title bar. The title bar in the window frame shows the name of the current 
document. 

II The menu bar . Use the menu bar to access the vuepad commands. 

III The tablet. This is the editing area. Use the scroll bars to view different 
portions of the document. 

This is the vuepad tablet. This is the area that you use to 
edit documents. 

Separate paragraphs with a blank line. 

Opening Documents 
There are several choices in opening documents: 

II You can open a new document or one that already exists. 
II You can open the document in an existing vuepad window or in a new 

vuepad window. 

To open a new document in a new 'vuepad' window: 

Double-click the VUEPAD action icon in the Applications directory. 
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To open a new document in an existing 'vuepad' window: 

Choose New. .. from vuepad's File menu. If you have unsaved changes in 
your current document, a dialog box asks you if you want to save the changes 
before it closes the current document and opens the new one. The window title 
is Text Editor - (unnamed) when you are working with a new document. 

To open an existing document in a new 'vuepad' window: 

1. Get a file manager view of the directory containing the document. 
2. Display the vuepad icon. 
3. Drag the document icon to the vuepad icon. 

To open an existing document in an existing 'vuepad' window: 

Use either of these methods: 

• Using the Open . .. menu command. 
1. Choose Open ... from the File menu. 
2. Use the Open File dialog box to select the file to be opened. (See the 

"U sing the Open and Include Dialogs" section later in this appendix.) 
• Drag a document icon to the tablet. 

1. Get a file manager view of the directory containing the document. 
2. Drag the document icon to the vuepad tablet. 

Entering Text 

Text is inserted at the current cursor position. Press {Return] to start a new line 
or use word wrap (see "Turning On/Off Word Wrap"). A marker shows the 
place where you last edited, inserted, or selected text. 
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This is the vuepad tablet. This is the area that you use to 
edit documents. 

Separate paragraphs with a lb lank line. A 

cursorJ L Marker 

Turning On/Off Word Wrap 

When you use word wrap, words continue on the next line when the cursor 
nears the right edge of the tablet area. 

When you save your document, you'll have a choice to add a newline character 
to the end of each word-wrapped line so that the printer will break lines at 
appropriate places. A newline character instructs the printer to break a line 
and start a new one. 

If you don't use word wrap, you must press (Return) at the end of each line. 
Pressing §tiimJ automatically adds a newline character. 

To turn on/off word wrap: 

Choose Word Wrap from the Edit menu. 

Caution , Don't use word wrap to edit configuration or resource files, 
such as vuewmrc or /etc/inittab or files you merge with the 
xrdb database. Some lines in those files cannot contain line 
breaks or newline characters. 

Starting a New Paragraph 

To start a new paragraph, create a blank line between the paragraphs by 
typing (Return) twice. 
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Moving the Cursor 

There are two ways to move the cursor: 

• By pointing to the new location and clicking mouse button 1. 

• Using the cursor movement keys. 

Cursor Movement Keys 

Key Moves the cursor ... 

(!) Up one line. 

(!) Down one line. 

@ Left one character. 

0 Right one character. 

(CTRL] 0 Right one word. 

(CTRL] ffi Left one word. 

[CTRL] (!) Beginning of the next 
paragraph. 

(CTRL] (!) Beginning of the previous 
paragraph. 

(!) or (Home ]1 Beginning of the current line. 

@2 End of the current line. 

( CTRL ] (!) or (CTRL) [Home )1 Beginning of the document. 

(CTRL] C!ZJ End of the document. 

IOn Domain/OS, [Home] is apLeftBar. 

2 On Domain/OS, @is apRightBar. 
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Scrolling the Tablet Contents 

There are several ways to scroll the window if the document is longer or wider 
than the tablet's display area: 

II Using the scroll bars. 

E Moving the cursor past the edge of the tablet. 

III Using the scrolling keys. 

Scrolling Keys 

Key Scrolls the text ... 

(Prev) or CEi]f) Up one page. 

(Next)or~ Down one page. 

( CTRL] (Prev ] or (CTRL) CEi]f) One page to the left. 

(CTRL] (Next) or (CTRL] ~ One page to the right. 

Editing Text 

Character Editing 

Use the following keys for simple editing. 

Editing Keys 

Key Action 

(Back seace) Delete the character before the cursor. 

( Delete char ) or @ill Delete the character following the 
insertion cursor. 

( CTRL) ( Delete char ) Delete all the characters from the cursor 
to the end of the current line. 

The Vuepad Editor A-7 



A 

Selecting a Block of Text 

You select text to move, copy, or delete the text block. Selected text is 
highlighted. 

To select a block of text: 

1. Move the cursor to the beginning of the block. 
2. You can now: 

• Hold down mouse button 1 and drag the cursor to the end of the text 
block. The text remains selected when you release the mouse button. 

• Double-click mouse button 1 to select one word. 
• Triple-click mouse button 1 to select the entire line. 
• Quadruple-click mouse button 1 to select the entire tablet. 

To add to or remove text from the selected area: 

Hold down (Shift] and mouse button 1 as you drag the cursor to the new ending 
point for the selection. 

To unselect text: 

Click mouse button 1 anywhere in the window. 

Moving, Copying, Removing, and Clearing Text 

Once text has been selected, it can be moved, copied, deleted, or cleared. 

To move a block of text: 

1. Select the text to be moved. 
2. Choose Cut from the Edit menu. The text is erased from the screen and 

stored in a temporary "cut buffer." 
3. Move the cursor to the location where the text will be inserted. 
4. Choose Paste from the Edit menu. 
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To copy a block of text: 

1. Select the text to be copied. 
2. Choose Copy from the Edit menu. A copy of the text is placed in the "cut 

buffer." 
3. Move the cursor to the location where the copy of the text will be inserted. 
4. Choose Paste from the Edit menu. 

To delete a block of text: 

1. Select the text to be deleted. 
2. Do one of the following: 

.. Choose Delete from the Edit menu. 
II Press (Backspace ), (Delete chad (or ~). 

Delete text when you want to remove lines of text. Deleted text is not put in 
the cut buffer, therefore, it cannot be pasted. However, you can recover the 
text with Undo. 

To clear a block of text: 

1. Select the text to be cleared. 
2. Do one of the following: 

.. Choose Clear from the Edit menu. 
IiII Press (Clear display). 

Clear text when you want to replace selected text with spaces or a block of 
selected text with a block of blank lines. 

Undoing an Edit 
The Undo operation reverses the last cut, paste, clear, delete, or include 
operation. 

To use the undo command: 

Choose Undo from the Edit menu. 
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Searching For and Replacing Text 

To search the document for particular text: 

1. Choose Find... from the Search menu to display the Find dialog box. 
2. Click the Find: box and type the text. 
3. Click [Find] to find the first occurrence of the text. 
4. To find additional occurrences: 

III Click [Find] again, or 
III Choose Next from the Search menu. 

To replace text: 

1. Choose Replace . .. from the Search menu. 
2. Click the Find: box and type the text to be replaced. 
3. Click the Replace With: box and type the replacement text. Or, you can 

copy the find text to the Replace With box and edit it, using the following 
procedure: 
a. Triple-click the text in the Find: box to select it. 
h. Move the pointer to the Replace With: box and click mouse button 2 to 

paste it into the box. 
c. Click the Replace With: box and edit its contents. 

4. Click [Find] to find and highlight the first occurrence of the text after the 
current cursor position in the tablet. 

5. If you want to replace the text, click [Replace]. 
6. Repeat steps 4 and 5 until you've completed the replace operation. 

Including a File in the Current Document 
The Include command inserts the contents of the specified file at the current 
cursor position. 
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To include a file: 

1. Choose Include . .. from the File menu. 
2. Use the Include dialog box to select the file to be inserted. For information 

on using this dialog box, see "Using the Open and Include Dialogs" later in 
this appendix. 

Formatting the Document 
Use the Format menu to format your completed document. The Format menu 
has the following choices: 

Settings ... Opens a dialog box in which you can set margins and 
justification for a paragraph or for the entire document. 

Paragraph Once settings are chosen, formats other selected paragraphs. 

All Once settings are chosen, formats the entire document. 

To format paragraphs: 

1. Choose Settings from the Format menu. 
2. Enter margins and choose justifications. 
3. Place the cursor in the paragraph that you want to format. 
4. Click [Paragraph] or choose Paragraph from the Format menu to apply the 

settings. 

To format the entire document: 

1. Choose Settings from the Format menu. 
2. Enter margins and choose justifications. 
3. Click [All] or choose All from the Format menu to apply the settings. 

vuepad remembers your formatting choices so you can choose Paragraph or 
All from the Format menu after the Settings dialog box is closed. 
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Running the Spelling Checker 

To check the spelling in your document: 

1. Choose Spell . .. from the Search menu. This runs the spelling checker 
and displays the Spell dialog box. 

2. Click on an entry in the Misspelled Words list to highlight it and display it 
in the Find text box. 

3. Enter the correctly spelled word into the Replace With: box. You can 
double-click the Replace With: box and type the word from the beginning. 
Or, you can copy the misspelled word and then edit it, using this procedure: 
a. Select the word in the Find text box by double-clicking it. 
b. Move the pointer to the Replace With: box and press mouse button 2. 
c. Click the Replace With: box and edit its contents. 

4. Click [Find] to find and highlight the first occurrence of the misspelled 
word. 

5. H you want to replace the word, click [Replace]. 
6. Repeat steps 4 and 5 until you've found all the occurrences of the misspelled 

word. 
7. To correct additional words from the Misspelled Words list, return to step 2. 

Printing the Document 
Choose Print from the File menu. Your document prints as it appears in the 
tablet area to your workstation's printer. 

The Print selection ties into the action data base through the file 
lusr/lib/Xll/vue/types/vuepad. ad. To change vuepad's print action, 
see the HP Visual User Environment System Administration Manual for 
information on actions. 
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Saving the Document 

Saving a new (unnamed) document creates a new file. You can save an existing 
document to its original file or save the edited contents to a new file. 

To save a new document: 

1. Choose Save... or Save As ... from the File menu. This displays the 
Save As Dialog dialog box. 

2. If word wrap was used to create the document, make the following choice: 
• Add newline characters at word-wrapped line breaks. When printing to 

the screen or printer, newline characters break a line and begin a new one. 
• Don't add newline characters at word-wrapped line breaks. 

Word-wrapped text prints to the screen or printer on one line. 
3. Supply the path to the new file in the Save File As: box. 

• Click the box and then edit its contents. 
• Double-click the box and type the new path. 

4. Click [OK]. 

To save an existing document to its original file: 

1. Choose Save from the File menu. 
2. If word wrap was used to create the document, make the following choice: 

II Add newline characters at word-wrapped line breaks. When printing to 
the screen or printer, newline characters break a line and begin a new one. 

II Don't add newline characters at word-wrapped line breaks. 
Word-wrapped text prints to the screen or printer on one line. 

3. Supply the path to the new file in the Save File As box. 
• Click the box and then edit its contents. 
• Double-click the box and type the new path. 

4. Click [OK]. 

The Vuepad Editor A·13 



A 

Using the Open and Include Dialogs 
This section describes how to use the Open File and Include dialog boxes. 
These two dialog boxes are nearly identical and are used to choose: 

• The document to open for editing. 
• The file to include in the document you are currently editing. 
• The file in which to save the contents of the tablet. 

File Filter: 

I/users/anna/.vue/* I 
"_"""~'~W."N"~"' __ """~~"~'_'""~W,"~""._'m .. "" .. ,._.,,,.W""_·"~W.W,~,~"".w.·.wm.·,.w_.~.w"~wm.'N'~" 

Directories 

Directories ~:i'""'i":'II"Ar .. h;llnlnaJ -..;,.:~~Flles 
List list 

filename box 

To use the diaiog box: 

1. Display it by choosing Open... or Include ... from the File menu. 
2. Examine the contents of Filename box. If it contains the directory path for 

the file you want (for example, you want to open file lusers/anna/. vue and 
the selection box contains lusersl annal): 
a. Click the file name in the Files list to append the file name to the path. 
b. Click [OK]. 

3. If the Selection box does not contain the directory path for the file you 
want, you have several choices: 
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II Click the Filename box and edit its contents so that it contains the 
complete path to the file, including the file name. 

II Double-click the Filename box and type the complete path to the file, 
including the file name. 

iii Use the File Filter to browse your file system and select the file. See the 
next procedure. 

To browse your me system using the File Filter: 

1. Click the File Filter box and type as much of the path as you know. Use the 
* character as a wild card. For example, you could enter /doc/projectl/* 
if you knew the file was located in a subdirectory of proj ect1. 

2. Click [Filter]. The Directories list and Files list change to reflect the new 
filter. 

3. Examine the Files list. If the file is in the Files list, proceed to step 5. 
4. Continue adding subdirectories until the Files list contains the file you want 

to open. 
9 To add an additional subdirectory to the File Filter, click a directory in 

the Directories list and click [Filter]. 
g To remove a subdirectory from the file filter, click the parent directory 

in the Directories list. The parent directory is the path editing with two 
dots. 

5. Click the file in the Files list box to append the file name to the path in the 
Filename box. 

6. Click [OK]. 

Making Vuepad Your Default Editor Action 

To make vuepad your default editor: 

1. If you have not already done so, copy /usr/lib/Xll/vue/types/user­
prefs. ad to /users/ your_login/ . vue/types. 

2. Edit the line that begins EDIT_TEXT so that it reads: 

EDIT_TEXT * ${ACTION_L} ${ACTION_S} MAP VUEPAD 
3. Reread the data base (open the systems_apps/sys_admin folder in your 

Applications directory and double-click the REREAD_DB icon.) 
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Glossary 

acceleration 
Mouse pointer velocity, relative to mouse movement. 

accelerator 
A key or sequence of keys (typically a modifier key and some other key) 
that provides a "shortcut," for accessing functionality. 

action database 
An ASCII text file that defines "actions" specific to HP VUE file types. 

active window 
The window where what you type appears. If there is no active window, 
what you type is lost. Only one window can be active at a time. The active 
window is said to have the "keyboard focus." 

application 
A software program used to perform work. Word processors, spreadsheets, 
and databases are examples of applications. 

application font 
The font displayed when text is typed in a window or text entry box. Also 
called user font. 

application server 
A workstation used solely to provide processing power for application. 

arrow keys 
Keys that can be enabled to control pointer movement. 
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I bitmap 
Generally speaking, an array of data bits used for graphic images. Strictly 
speaking, a pixmap of depth one (capable of representing 2-color images). 

buffer 
An area used for temporary storage. 

button 
A button on a mouse pointing device. Mouse buttons can be mapped to 
the keyboard. Also, a graphical image used frequently in dialog boxes that 
resembles real push buttons in appearance and behavior. 

button binding 
Association of a mouse button operation with a workspace manager 
function. For example, pressing button 3 on a window frame displays the 
window menu. 

cancel 
A push button that closes a dialog box without implementing any changes. 

check button 
A control used to select settings that are not mutually exclusive. Usually, 
the button is filled in (checked) when it is selected. 

click 
To press and release a mouse button. The term comes from the fact that 
pressing and releasing the buttons of most mice makes a clicking sound. 

color set 
A collection of colors that define the foreground, background, and shadow 
colors of a particular display element. A color palette consists of a 
collection of color sets. 

computer hardware 
The electronic and mechanical components of a computer system. 

<Ctrl> key 
The keyboard key, pronounced "control", that is used as a modifier key. 
You hold down this key while pressing another key. 
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current session 
The session to which you are logged in at a particular time. 

cursor 
An image used to locate the focus of keyboard input. The cursor can take 
several forms. The oblong box around a control is the selection cursor. An 
I-shaped image or a caret ( ... ) are used as text entry cursors. 

dialog box 
Sometimes called a secondary window, the dialog box is called by the user 
from the main window. A dialog box contains controls and settings. To 
display an example of a dialog box, click the style manager button on the 
workspace, then click Color. 

direct manipulation 
U sing the mouse to copy or otherwise handle files and directories, and do 
other operations like "push" buttons. 

directory 
An organizational unit of your workstation's disk drive composed of files 
and subdirectories. A directory is analogous to a file folder containing 
letters (text files), which is contained in a filing cabinet (disk). 

disk drive 
A rotating magnetic disk upon which information can be stored and 
retrieved. 

double-dick 
Pressing and releasing a mouse button twice in rapid succession. 

drag 
Pressing and holding down a mouse button while moving the mouse on your 
desktop (and the pointer on the screen). 

drop 
Releasing an icon that has been "dragged" to a new position. To drop the 
icon, release the mouse button. 
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DSL 
The abbreviation for Disk System Loaded, the HP "Instant Ignition" 
product that comes with the software factory-installed on the disk drive. 

entry box 
An area used for text entry. 

environment variable 

file 

An element of your workstation software that can be set to a value, then 
read by applications to influence their behavior. Such elements define 
characteristics such as SHELL (your default command interpreter), MAIL 
(where to look for electronic mail), and TZ (the local time zone). 

An organizational unit of the disk drive composed of bytes of.information. 

file manager 
The HP VUE application that allows you to manage your files and 
directories, and set viewing preferences. 

file server 
A computer whose primary task is to control the storage and retrieval of 
data from hard disks. Any number of other workstations can be linked to 
the file server in order to use it to access data. This means that less storage 
space is required on each individual workstation. 

font 
The style, size, and weight (regular, italic, or bold) of text characters. 

graphical user interface 
A form of communication between people and workstations using 
graphics-oriented software such as windows, menus, and icons, to ease the 
burden of the interaction. 

help manager 
The HP VUE application that provides online help. 

highlight 
A graphic technique to show the current selection or the location of the 
input focus. ' 
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$HOME 
The environment variable representing the home directory. This is the 
directory in which you are placed after you log in. Typically, this is 
/users/login, where login is your login name. The home directory is where 
you keep all "your" files. 

home session 
A session stored explicitly using the style manager Startup dialog box, to 
which you can always return. 

host 
Another computer on the network. The term "host name" is the name by 
which the computer is known to other computers on the network. 

hotspot 
The area of a pointer that is defined as the "point" of the pointer. 

icon 
A small, graphic representation of an object on the workspace (typically an 
application window). Objects can be "iconified" (turned into icons) to clear 
a cluttered workspace and restored (returned to their original appearance) 
as needed. Processes executing in an object continue to execute when the 
object is iconified. 

ieonbox 
The box created by the workspace manager that is used to store icons. 

iconify 
The act of turning a window into an icon. 

indicator 
A non-interactive icon, such as the clock, load indicator, etc. 

input device 
Any of several pieces of equipment used to give information to a system. 
Examples are the keyboard, a mouse, or a digitizer tablet. 

input focus 
When a program has input focus, it receives input from the keyboard and 
mouse. 
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keyboard binding 
Association of a special key press with a workspace manager function. For 
example, pressing the special keys (Shift) + (Esc) displays the system menu of 
the active window. 

login 
Your login name, or simply "login", is the name by which you are known to 
the workstation. This may be any group of characters, so long as it meets 
system rules. 

login manager 
The program that controls the initial startup of HP VUE, accepts the user's 
login and password, and then starts the session manager. 

login screen 
The screen that accepts your login and password. 

lower 
To move a window to the bottom of the window stack on the workspace. 

main window 
See window. 

maximize button 
A window-frame push button used to enlarge the window to its maximum 
size. 

menu 
A list of action options that is displayed in the upper left corner of a 
window when you press the window menu button on the window frame. In 
a graphical user interface such as HP VUE, menus enable you to control 
workstation operation. Every window has a menu that enables you to 
control the size, shape, and position of that window. 

menu bar 
An area at the top of a window that contains the titles of the pull down 
menus for that application. 
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minimize 
To turn a window into an icon. The terms minimize and iconify are 
interchangeable. The mimimize button is a push button on the window 
frame that is used to minimize the window. 

mnemonic 
A single character (frequently the initial character) of a menu selection 
which, when the menu is displayed and the character is typed on the 
keyboard, initiates the selection. 

modifier key 
A key that, when pressed and held along with another key, changes the 
meaning of the other key. (CTRL ), (Extend char ), and (Shift) are examples of 
modifier keys. 

mouse pointer 
See pointer. 

navigation keys 

Glossary 

The keys that move the pointer. These are the four arrow keys and the tab 
key. 

newline character 
A character that can be added to the end of lines of text in a document. 
It tells the screen or printer to break a line and start a new one. You can 
add a newline character by pressing (Return) when editing a document or 
by choosing to add newline characters when saving a file created with the 
Vuepad editor. 

operating system 
The software that controls the file handling and file manipulating low-level 
functions of your workstation by talking directly to the hardware. 

output device 
A piece of hardware used for receiving messages from the workstation. The 
display screen of your workstation is an output device. The printer you use 
is another. 
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palette 
A collection of color sets that creates an attractive color scheme for the 
display. Each palette has a unique name. 

parent directory 
The directory located immediately above a directory in a hierarchical file 
structure. A directory containing subdirectories is their parent directory. 

password 
A unique word known only to you (and possibly your system administrator) 
that acts as a security countersign, further identifying you to the computer. 

point 
To position the pointer or location cursor. 

pointer 
Sometimes called the "mouse pointer," the pointer shows the mouse 
location on the screen. The pointer's shape depends on its location. In 
the workspace, the pointer is an x. On a window frame, the pointer is an 
arrowhead. 

pointing device 
A device that moves the pointer on the display screen. A pointing device 
is used with a graphical user interface, like HP VUE, that allows you to 
select and manipulate a graphical object by "pointing" to it. The mouse is 
probably the most familiar pointing device. 

property 
An attribute of a file or directory. 

push button 
A graphic control that simulates a real-life push button. Use the pointer 
and mouse to push the button and immediately start an action. Radio 
buttons come in sets of two or more. Each button represents a mutually 
exclusive selection. Radio buttons are typically used for setting states or 
modes. 

remote host 
A computer physically removed from your own that you can log in to. 
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resize 
To change the height or width of a window. 

resize handles 
The frame part of the window that is used to change the height or width of 
the window. 

resource 
A component of the X Window System resource data base. Resources 
control the appearance and behavior of parts of the system. 

restore 
The act of changing an minimized (iconified) or maximized window 
back to its regular size. The terms restoring and normalizing are usually 
interchangeable. 

root directory 
The primary directory in a file hierarchy. 

scroll bar 
A graphical device used to change your viewpoint of data. A scroll bar 
consists of a slider, scroll area, and scroll arrows. A person changes the 
view by sliding the slider up or down in the scroll area or by pressing one of 
the scroll arrows. 

session 
The time between when you log in and when you log out. 

seSSIOn manager 
The program that provides the ability to restore the previous or home 
session the next time the user logs in. When a user logs in, the session 
manager starts the workspace manager and other programs that were 
running during a previous session. 

server 
A program that controls all access to input devices (typically a mouse and a 
keyboard) and all access to output devices (typically a display screen). It is 
an interface between application programs you run on your workstation and 
the workstation input and output devices. 
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shell script 
An executable ASCII text file usually containing system commands. 

slider 
One of the components of a scroll bar or slider bar. The slider is the object 
that is dragged along the scroll area to cause a change. 

sty Ie manager 
The HP VUE application that provides the ability to customize various 
aspects of your system, including colors, fonts, the keyboard and mouse, 
session startup and termination behavior, and access to other machines. 

system administration 
A variety of maintenance tasks usually performed by the system 
administrator in charge of the workstation. These tasks include rg.onitoring 
disk space, creating a recovery system, making backups and otherwise 
maintaining the integrity of the data files, adding new users, maintaining 
network communication with remote hosts, shutting down the system, and 
modifying configuration files to improve workstation efficiency. 

system font 
The font used for window titles, menu bar labels, and button labels. 

system processing unit 
The part of the workstation hardware that does the actual computing. 
Generally, the "box" part of the workstation as opposed to the display. 

terminal window 
A terminal window is a window that emulates a complete display terminal. 
Terminal windows are typically used to "fool" non-client programs into 
believing they are running in their favorite terminal. When not running 
programs or executing operating system commands, terminal windows 

. display the command-line prompt. 

text cursor 
See cursor. 

text entry box 
See entry box. 
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threshold 
The distance the mouse pointer moves before accelerating. 

title area 
The area at the top of the window frame that contains a title or name 
for the window. The title area can be grabbed and dragged to move the 
window. 

title bar 

Glossary 

The title bar is the rectangular area between the top of the window and the 
window frame. The title bar contains the title of the window object; for 
example, "Terminal Window", "File Manager", or "Rename Workspace". 

tree structure 
A method of organizing files and directories into a hierarchical structure. 
This structure looks like an inverted tree with the "root" directory at the 
top, descending into multiple directory branches that end in clusters of files. 

user font 
See application font. 

user interface 
The medium through which users communicate with their workstations. 
The command-line prompt is one type of interface. The real-life oriented, 
graphical objects of HP VUE represent another type of interface, a 
graphical user interface. 

window 
A rectangular area of the screen used by HP VUE to contain a particular 
application. Client applications can have multiple windows, but one 
window is always the "main" window. The workspace manager provides 
the ability to move, resize, and shufHe windows, and also provides the 
window decorations such as the frame and title bar. Windows, which are 
also called "primary windows" or "main windows", can usually be iconified, 
and usually have a menu bar. 

window frame 
The area surrounding a window. A window frame can consist of a resize 
border, a window menu button, a title bar, and window control buttons. 
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window manager 
The program that controls the size, placement, and operation of windows 
on the root window. The window manager includes the functional window 
frames that surround each window object as well as a window and 
workspace menus. If the window manager supports workspaces, it is called 
a workspace manager. 

window menu 
The menu that displays when you press the window menu button on a 
window frame. It lets you control the size, shape, and position of the 
window. The window menu button, which is the control button at the left 
side of the title bar in the window frame, allows you to display the window 
menu. 

workspace 
The workspace is what the "screen" (the flat viewing surface of the 
terminal) becomes when you start HP VUE. To a certain extent, you 
can think of the workspace as the screen. Although you can hide the 
workspace under terminal windows or other graphic objects, you can never 
position anything behind the workspace. All windows and graphic objects 
appear "stacked" on the workspace. Use the workspace switch to switch 
workspaces. 

workspace manager 
The program that controls the size, placement, and operation of windows 
on the workspace. The workspace manager includes the workspace manager 
itself (sometimes called the "front panel") and the functional window 
frames that surround each window, program (Vuewm), as well as window 
and workspace menus. 

workspace menu 
The menu associated with the workspace. The workspace menu enables you 
to control the behavior of your environment. Also called the "root" menu. 

workspace switch 
The set of push buttons in the workspace manager that let you switch from 
one workspace to another. 

workstation 
A graphics-oriented computer. 
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replacing text, vuepad, A-I0 
reread directory, 6-21 
RES_EDIT action, 8-2 
resizing window contents, 4-17 
resource database 

adding resources to, 8-2 
resources 

adding to the resource database, 8-2 
editing with RES-EDIT action, 8-2 

restarting 
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a session, 3-8 
the server, 3-4 

restoring 
a session, 3-8 
directories, 6-18, 6-19 
files, 2-22, 6-18, 6-19 
palettes, 7-10 

right-handed mouse button settings, 
7-15 

root directory 
changing to, 6-8 
going to, 6-22 

S 

Save as dialog, A-13 
scope 

specifying for a search, 6-17 
Screen dialog box, 7-18 
screen saver time out intervals 

specifying, 7-18 
scroll bar 

using, 2-4 
scrolling, 6-10 

vuepad, A-6 
searching 

a specific directory, 6-17 
by modification date, 6-18 
by size, 6-17 
for a man page, 5-11 
for a word, 5-10 
for specific files, 6-17 

searching for text, vuepad, A-I0 
security, 3-5 
Select All, 6-12 
selecting 

directories, 6-10 
files, 6-10 
help topics, 2-27 
randomly, 6-11 
range of icons, 6-11 
single objects, 6-11 



using the View menu, 6-12 
selecting text, vuepad, A-8 
sending and receiving mail, 4-11 
server restarting, 3-4 
services on workspace manager, 4-3 
session 

locking and unlocking, 3-6 
management, 3-1 
restoring and restarting, 3-8 

Session Startup dialog box, 7-22 
Set Preferences dialog box, 6-24 
setting viewing preferences, 6-24 
single selection, 6-11 
SIze 

searching by, 6-17 
(Snapshot ), 5-6 
specifying 

how you want your next session to 
start, 7-22 

screen saver time out intervals, 7-18 
spell checker , A-II 
starting 

a terminal window, 4-3 
file manager, 4-3 
help manager, 4-3 
style manager, 4-3 
workspace manager services, 4-3 

status line, 5-7, 6-7 
icon, 6-7 

status of printer, 4-12 
style manager, 7-2 

getting help, 7-3 
opening, 2-9 
opening and closing, 7-2 

switching 
between texts, 5-9 
workspaces, 2-9, 4-3, 4-4 

syntax 
action definitions, 8-18 
file type, 8-15 
key binding, 8-24 

menu, 8-10 
mouse button, 8-24 
workspace manager, 8-5 

system applications, 4-13 
system_apps, 6-32 
system security, 3-5 

T 

tablet, vuepad, A-3 
terminal window, 4-16 

closing, 2-13 
opening, 2-13 

threshold 
changing, 7-16 
mouse pointer, 7-15 

time out intervals 
screen saver, specifying, 7-18 

tips 
editing, 2-6, 2-8 

toggling the workspace manager, 4-6 
trash can, 4-3 

deleting files, 4-14 
using, 6-19 

Trash file(s), 6-19 
tree 

directory, 6-25 

U 

understanding 
menu syntax, 8-10 
mouse button and key binding syntax, 

8-24 
unlocking your session, 3-6 
Unselect All, 6-12 
unselecting, 6-12 
updating 

a directory, 6-21 
a file manager view, 6-21 

using 
Actions menus, 6-31 
Copy As ... ,6-14 
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file manager, 6-10 
help manager, 5-5 
Help menus, 5-4 
mouse, 2-2 
system files as models, 8-13 
window menus, 4-9 
workspace manager, 4-2 

vi, 2-13 
VIEW, 6-6, 6-31 
viewing 

help text, 5-5, 5-6 
help topics, 2-27 
system files, 8-13 

viewing preferences,setting, 6-24 
View menu, 6-5 
View menu 

selecting, 6-12 
vuepad 

clearing text, A-9 
copying text, A-9 
cursor, A-4 
default editor, A-15 
deleting text, A-9 
editing keys, A-7 
formatting, A-II 
icon, A-I, A-2 
justifying text, A-II 
margins, A-II 
moving text, A-8 
opening a document, A-3 
paragraphs, A-5 
print action, A-12 
printing a document, A-12 
replacing text, A-I0 
saving a document, A-13 
scrolling text, A-6 
searching for text, A-I0 
selecting text, A-8 
spell checker, A-II 
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starting, A-I 
tablet, A-3 
turning word wrap on/off, A-5 
undoing edits, A-9 
window, A-2 

Vuestyle*writeXrdbImmediate, 7-10, 
7-16 

vuewmrc file, 8-4 

W 

wild card, 8-17 
window contents resizing, 4-17 
window menu 

editing, 8-11 
window menu using, 4-9 
windows, 2-4 

buttons, 2-4 
dragging, 2-4 
making active, 2-4 
moving, 2-4 
resizing, 2-4 
shuffling, 2-4 
using terminal windows, 4-16 

word searching, 5-10 
word wrap, turning on/off, A-5 
workspace 

backdrops, changing, 2-10, 7-12 
colors, changing, 2-11, 7-4, 7-5 
management, 4-1 
renaming, 2-8, 4-5 

workspace manager 
adding an application, 8-7 
adding applications and indicators 

to, 8-6 
examples, 8-5 
getting help, 4-6 
hiding, 4-6 
indicators, 4-2 
layout, customizing, 8-4 
logging out, 4-6 
removing a control from, 8-6 
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services, 4-3 
syntax, 8-5 
using, 4-2 

workspace manager resource file, 8-4 
workspace menu 

choosing from, 4-7 
creating, 8-11 
editing, 8-11 

Workspace Presence, 4-10 
workspaces 

switching, 2-9, 4-4 

workspace switch, 4-3 
workstation 

and HP VUE, 1-3 
locking, 4-3 

writ eIrdblmmediat e, 8-4 

X 

xrdb 
changing resources with, 8-3 
used by RES_EDIT action, 8-3 
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